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Getting Started
Start by installing the program and learning how to open it.
Select an image to rectify: You might as well start with one of the samples included with the distribution. (ASRix v2.x
can work with .JPG and .BMP files with an 8 or 24 bit colour depth)
Open

the image using the icon on the toolbar or the File->Open menu item.

Maximize the Source Window and zoom until you can see the points for which you have real world coordinates. F10
zooms in F11 zooms out and F12 will fit the image to the available space. If you have a wheel mouse rolling the ball
can do the zooming.
Map Points on the image to points in the real world:
Move the cursor near one of your points and double click. You will be presented with the Point Mapping dialogue Box
where you can fine tune the placement of your point and enter the values for the coordinates of that point. Then Click
OK and repeat for the rest of the points for which you have coordinates. (A minimum of 4 points are required)
To move a point:
Click and hold the left mouse button when the cursor is on the point and drag it into place or, while holding the mouse
button, use the cursor keys to move the point in 1 pixel increments. This works the same in both the Source Window
and in the Point Mapping dialogue box.
If the point is difficult to see:
You can adjust the colours of things from the Properties dialogue box.
Rectify:
When all your points are correctly placed click the rectify button on the toolbar or the Tools->Rectify menu item to
rectify the image.
If your points were good you will have a rectified image, if your points were not good you will have something else
and you should look at the section on Trouble Shooting to figure out what went wrong. (Usually it's points out of order
or bad measurements in the field)
The first step in understanding how the ASR Rectifier works will be getting to know the help facility and after that an
understanding of the toolbar, the menus and the various input methods will get you ready to tackle the section on using
the rectifier and start using (B)ASRix on your own material.

Installation
Note: The ASRix you download from the web is a full featured version but it will run for only 50 days from it's first
installation. After that it will demand a user ID and activation key.
As ASRix is still under constant development when your trial period expires you can try downloading it again and, if it
is newer than the version you were running the trial period will be reinstated. However, if there have been no updates
since you last installed a new version you will have to buy a licence :)
The ASRix distribution described in these pages is a self-installing executable (currently) ASRixV2.beta.exe which
can be downloaded from the ASRix web site: http://asrix.ca/
You can either open this file directly, over the internet, or save it to your hard drive and run it from there.
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During the download/installation process you may be confronted with a couple of warning messages:

Here you can select either Run or Save. If you choose to save the file you will have to run it later to complete the
installation.

The second warning message is generated because we are unknown to Microsoft. It's another expense and hassle we're
not ready to take on just yet. Needless to say you will have to select Run to install the program.
After that it is the usual Install Shield stuff. You will have to agree to the terms of our licence, enter your name, etc.
The first real decision you need to make is where to install the program. By default it will go to C:/Program
Files/ASRix but you can put it anywhere you want.
Next you will need to decide whether to do a Complete, Compact (missing the AutoCAD components) or Custom
installation:
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The whole package is not huge (about 30 meg) so the only reason not to do a Complete installation would be if you will
NOT be using the AutoCAD interface.
If you select Custom you will be presented with the following dialogue box:

When Custom has been selected the default will be to install everything except the AutoCAD interface and samples. To
change an option select the check box to the left of the component.
If you run the install program again or if you select the Change/Remove button under Add or Remove Programs you
will see the following dialogue box which will allow you add or delete a component or uninstall ASRix.
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When updating an existing installation the easiest thing to do is to select the Repair option.
Note: If you have installed the AutoCAD Interface or saved any of the sample files, Uninstall may not completely
remove the program directories from your computer and you will have to remove them manually.
z Note Also: The AutoCAD features must be uninstalled from an AutoCAD session before you uninstall ASRix using
Add or Remove Programs. Please read the section on AutoCAD Installation for complete instructions.
z

A complete installation will create an ASRix icon
under Programs

on your desktop and the following entries on your Start Menu

Please read the section on using ASRix and check the Samples some of which may prove helpful in understanding what
is going on.
At the time of this writing the following files were included in the distribution:

_Read_Me.txt
ASR.DCL
ASR.MNL
ASR.MNU
ASR-grid.dbf
ASR-grid.dwg
ASR-grid.pdf
ASR-grid.pts
ASR-grid-1.pdf
ASR-grid-9.pdf
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ASRix.chm
ASRix.exe
ASRix.INI
ASR-set.lsp
Copy of ASRix.INI
default.INI
ideal.INI
ijl15.dll
install.dwg
install.scr
samples
samples\archaeol.dbf
samples\archaeol.dwg
samples\building.dbf
samples\building.dwg
samples\building.jpg
samples\cube.bmp
samples\cube.dwg
samples\data
samples\images
samples\photo.dwg
samples\pts
samples\tape-3.jpg
samples\tape-3t.jpg
samples\tape-3t.PTS
samples\wall.dwg
samples\wall.jpg
samples\wall-2d.PTS
samples\wall-3d.PTS
samples\data\arch.csv
samples\data\arch.dbf
samples\data\BLDG.CDF
samples\data\BLDG.CSV
samples\data\BLDG.FIX
samples\data\BLDG.PKT
samples\data\BLDG.PTS
samples\data\BLDG.SDR
samples\data\BLDG.SPA
samples\data\BLDG.TAB
samples\data\BLDG.TXT
samples\data\CART.DBF
samples\data\CART.STR
samples\images\2awwe01.jpg
samples\images\2awwe03.jpg
samples\images\black.bmp
samples\images\blue.bmp
samples\images\cyan.bmp
samples\images\front.jpg
samples\images\green.bmp
samples\images\grey.bmp
samples\images\left.jpg
samples\images\magenta.bmp
samples\images\red.bmp
samples\images\roof.jpg
samples\images\white.bmp
samples\images\window.jpg
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samples\images\yellow.bmp
samples\pts\2awwe01.PTS
samples\pts\2awwe03.PTS
samples\pts\blue.PTS
samples\pts\building.PTS
samples\pts\cyan.PTS
samples\pts\front.PTS
samples\pts\green.PTS
samples\pts\grey.PTS
samples\pts\left.PTS
samples\pts\magenta.PTS
samples\pts\red.PTS
samples\pts\roof.PTS
samples\pts\tape-3t.PTS
samples\pts\wall-2d.PTS
samples\pts\wall-3d.PTS
samples\pts\white.PTS
samples\pts\window.PTS
samples\pts\yellow.PTS

Installing the AutoCAD Utilities
To use ASRix from within AutoCAD you have to tell AutoCAD where to find the ASRix program files.
If you installed the AutoCAD components of the ASRix release there will be an "Install AutoCAD Interface" menu

item in the ASRix section of the Program area of your Start menu.
If it is not there you will have to install these components either by using the Change/Remove option in Add or
Remove Programs or by reinstalling ASRix, being careful to include, at least, the AutoCAD Interface component.
This is explained further in the section on ASRix Installation.
Selecting the Install AutoCAD Interface menu item will open AutoCAD with the drawing INSTALL.DWG in the
ASRix directory *
Instructions are written in this drawing but basically what you have to do is type "SCRIPT" and select install.scr
which should be the only one listed. If you don't get a file dialogue box accept the default or type install at the
command prompt)
This will cause the ASRix menu to load after which you will be presented with a list of the directories on the ACAD
search path from which you must select an appropriate location for ASRix.LSP, a small file (less than 500 bytes) which
provides the link between ASRix and AutoCAD.
For instance, a standard AutoCAD R14 installation will have a search path that starts like the following:
C:\Program Files\AutoCAD R14\support
C:\Program Files\AutoCAD R14\fonts
C:\Program Files\AutoCAD R14\help

though most AutoCAD users will have added one or more other directories which contain their custom utilities, symbol
libraries etc. Normally you would choose one of these custom directories, if they exist so that you won't have to
file://C:\Documents and Settings\Steve\Local Settings\Temp\~hh869C.htm

21/01/2005

Getting Started-ASRix Help

Page 7 of 12

reinstall ASRix.LSP if you upgrade your AutoCAD but the ASRix AutoCAD utilities will work exactly the same in
any of the directories listed in the dialogue box.
In the two examples shown below (one ACAD R14, the other Autodesk Map 2005) the directory O:/support is
common to both AutoCAD installations and if this is selected ASRix will work with both.

The ASRix menu can be unloaded at any time by selecting the Unload ASRix option near the bottom of the ASRix
utilities menu or using the customize menus utility in AutoCAD.
Once installed the ASRix menu can be reloaded at any time by typing (load "ASRix") at the command prompt. This
will work for all instances of AutoCAD installed on a single machine.

* This would be the same as using your file manager to locate the directory where ASRix is installed ("C:\Program
Files\ASRix\" if the defaults were accepted) and launch AutoCAD by double clicking the drawing. You must load the
drawing in this way so that the install routine can locate all the elements it needs.
For many purposes the results rectifying images taken with an un-calibrated camera will provide adequate results,
especially if the focal length is not too short and/or if only the centre portion of the image is used, but there are
situations where the distortion caused by wide angle lenses and poor lenses will produce images of unacceptable metric
accuracy. To overcome such errors you will have to calibrate your camera.
ASRix has adapted an algorithm developed by George Karras and Dionyssia Mavrommati, which was presented to the
CIPA International Symposium in Potsdam, Germany in 2001 with the title of: Simple Calibration Techniques for NonMetric Cameras
By photographing and rectifying a grid ASRix will calculate parameters for lense distortion that can them be applied to
any image photographed with the same camera using the same settings for zoom and focus.
You will have to use identical camera settings for both the calibration and the surfaces to be rectified which sounds
easy but you will find that your camera will do everything in it's power to thwart you by changing the focus and
aperture settings without warning. The idea is that you are calibrating the geometry of the lens in relation to focal plane
or CCD of the camera. The factors that matter are:
z

z

z

Focal length (or zoom) which you can usually control but which might change when you turn the camera off (or
when it times out on it's own). If you are lucky the extreme settings, fully wide angle of fully telephoto, will
provide a consistent geometry but you should calibrate several images taken during different sessions before you
can count on this. Almost all photographs destined for rectification will be taken with the lens set to maximum
wide angle. Don't worry that there is distortion, removing this is what the calibration routine is all about.
Focus which, on most digital cameras, is normally set to Auto which for calibration purposes is very bad. You
will need to override this feature and set the focus manually to infinity. If the focus on your surfaces is not as
crisp as you might wish try to improve it by narrowing the aperture and decreasing the shutter speed.
Aperature has a limited effect on lens geometry but it is good to keep it constant if you can. Also a smaller
aperture (higher number) increases the crispness of the focus and tends to use the central part of the lense which

file://C:\Documents and Settings\Steve\Local Settings\Temp\~hh869C.htm

21/01/2005

Getting Started-ASRix Help
z

z

Page 8 of 12

typically has less distortion than the extremities.
Shutter Speed should have no effect on lense geometry but the faster it is the less likely hood you will have
problems with camera movement (tripods are a good idea in any event).
Resolution has no effect on lens distortion but it should be kept constant for calibration and rectified images.

A careful reading of your camera's manual may turn up ways to override these automated functions but not all cameras
have the necessary controls and if your's falls into this category this feature will not be useful and may further distort
your image. If this is your situation you can stop here.
To calibrate your camera start with the file ASR-grid.pdf which is included with ASRix. The first page of this file
shows a grid of 10 x 13 numbered targets. This can be printed as a single sheet as large as your printer will allow and,
in many cases, this print will be all you need.
Slightly better results can be expected from a larger target grid and for this pages 2-10 which are enlargements of the
grid can be printed on a normal letter sized printer then glued or taped together to form a collage. When using multiple
sheets care must be taken to accurately align the targets (pins through the target centres is a good way to do this).

You should then mount your grid on a flat surface and photograph it using the same camera settings you will be using
(or used) to photograph the surfaces to be rectified.
When taking this image don't worry if it is out of focus. You will still be able to determine the centre of the targets.
Remember you are trying to keep the lens the same as when the surface to be rectified was (or will be) photographed.
Also you should try to fill the image frame with the grid or, if you do not, you should try to use only the area covered
by the calibration to collect the image of the surfaces you wish to rectify.
The next step is to download the image of the grid and open it with ASRix
Use the Database Connection feature to attach the database file ASR-grid.dbf which you will find in the directory
where you installed ASRix.
Starting with point 1 in the upper left hand corner select each point in order, zooming in enough to ensure you have an
accurate placement of each point.
When all 130 points have been accurately positioned you will have a display that looks something like the following:
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When you are satisfied that all points have been accurately positioned go to the Tools Menu and select Camera
Management
The camera selected as default when you close the Calibrate Camera dialog box will become the default for all future
rectifications until you change it by calibrating another camera/lense combination or selecting a different camera via
the Output Parameters dialog box at the time of rectification.
Whenever there is a current camera defined, which should be most of the time if you are using a digital camera, it will
be possible to view the corrected, but un-rectified, image by selecting the
icon on the toolbar or the Corrected
Source Image item in the View Menu
As well, under the Tool Menu there is an option Save Corrected Image which will save the source image corrected for
lense distortion before rectification.
There is no need to save this image, whenever rectification is performed the image will be first corrected for distortion
(based on the current camera) and then rectified. Only the rectified has any metric significance but sometimes it's
interesting to see the steps such as below.
Source:
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Corrected:
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Rectified:
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Using ASRix
For a quick overview and some sample images check the Getting Started section.
The basic function of a rectifier like ASRIX is to take an image, photographed at an oblique angle, and stretch it to fit
measurements taken from the object itself. The result, if all goes well, is an image with the metric characteristics of an
architectural elevation or plan, ie. A 2 dimensional projection of the photograph onto a plane determined by the users
measurements of the object.
Your source materials then are the photographs and the measurements and of the two the measurements are by far the
most important. You can get a pretty good result from a poor photo but little of use can be extracted if the
measurements are faulty. These two components are combined using the point mapping dialogue box.
Working in the source image window you double click on one of the points for which you have measurements and
enter the coordinates for that point
Once you have a minimum of four points identified you can define your output parameters (closing this dialogue box
will rectify the image).
If you are using 3D coordinates there is another step which takes place most clearly in the point list window, where you
must define the axises of the plane to which you want the image rectified.
The rectified image will be in the same format as your source image and will have the same name as the source image
but with a .ASR. inserted between the filename and the extension.
The reliability of this image can be determined from the residuals and, if using 3D coordinates, the Z deviation which
can be seen in the point list window.
If the on-screen information is difficult to see over your image the colours and extents of the display can be adjusted
using the Display Properties dialogue box.
Advanced users and those exploring the samples will need to familiarize themselves with the Alternate Point File
dialogue box.
If you do not get the results you were expecting you should read the rest of this help manual then check the sections on
Trouble Shooting and Known Bugs both here and the on-line version (which may be more up to date) to see if your
problem has precedents.

Taking Photographs
Almost any photograph of a flat surface can be used for rectification. Of course, the quality of the resulting rectified
image will be directly proportional to the quality of the source image and there are a few additional parameters over
and above those common to all photographs (focus, lighting, stability, etc.) that will have an effect.
The photo should be taken from as close to right angles to the surface to be rectified as is possible. This is not to say
that seriously oblique images cannot be used, only that the quality of the result will be better if the software does not
have to make huge adjustments.
The points to be measured should be clearly visible. This requirement may conflict with the need to show detail in
the areas you cannot measure but this can be got around by taking multiple photographs - one for identifying the
measurement points, and others exposed for detail in other areas.
If all the photos are taken from the same location (i.e. using a tripod) and with the same orientation and focal length the
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point mapping files will be interchangeable among the images using the alternate point file feature of ASRix.
An extreme example of this would be the archaeological practice of placing a grid of a known spacing over the area to
be photographed and taking two photos - one with the grid in place and one without. The image with the grid can be
easily rectified and the resulting point file can be used on the image without the grid to get a rectified image of the
artifacts.
Targets or scales on walls can also be used in this way. One simple approach is described in the TAPES example in the
samples.

Taking Measurements
Your measurements are the key to getting useful images from the rectifier.
z
z
z

They must be reasonably accurate,
they must approximate a plane surface, and above all,
they must relate to a consistent coordinate system.

It is this latter condition that might pose some difficulties in some cases, depending on how your measurements are
collected.
z

By Survey it is relatively easy. Your measurements will be in 3 dimensions, X, Y & Z but ASRix in spite of
producing a 2D result will accept such measurements. Use the point list to identify the Origin, Horizontal axis
and Vertical axis of your coordinate system. This is discussed in more detail in the section 3D coordinates.
Check the deviation from the 2D plane (the Z-deviation column in the point list window) of the other points to
make sure everything is, at least, close to being on that plane. Then rectify as usual.
If the image is not rotated as you would wish it you can use the rotation options of the output parameters
dialogue box, or draw a Base Line in the Rectified Image Window to straighten it out.
If you get a mirror image it is because you have incorrectly defined the direction of the Horizontal axis (probably
swaping Origin, Horizontal will fix it) or you can select one of the mirror options from the output parameters
dialogue box.

z

Hand Measurements are another problem entirely. Here you will, in all probability, be using 2 dimensional
measurement system and the challenge is to establish the two axises at right angles to each other.
{ On the ground this can be accomplished with stakes and strings and the 3-4-5 method
(sum of the squares of the sides equals the square of the hypotenuse Pythagoras)
{

z

For vertical surfaces a plumb bob and a string or water level will help a lot. Use these lines as your axises
and measure identifiable points relative to them.

Grids and Scales Two, visibly calibrated, plumb lines aligned with a level and placed a known distance apart
could provide identifiable points for the rectifier without the need for further measurements. An example of this
approach is described in the TAPES example in the samples.
For small objects, such as an archaeological square or a wall or floor detail, a grid can be placed over the area of
interest. If a tripod mounted camera is used multiple photographs can be taken (with and without the grid device)
and the point file from the example with the grid can be used to rectify the photographs without the device using
the alternate point file feature.

z

Archival Photos, even of damaged or destroyed buildings, may provide useful results by measuring artifacts
such as foundations, windows and doors, etc.
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Point Mapping
Your main task when using any rectifier is mapping points on your photograph to points in the real world so you need
to become familiar with the Point Mapping dialogue box. You should also look at the section on taking measurements
for some ideas about establishing your coordinate system.
Placing the points in the source image is generally most easily done by establishing them with a double mouse click
near where you want them then moving them into position in the window in the Point Mapping dialogue box, where
you can zoom in for precision placement.
note: If you are having trouble placing the point exactly where you want it the arrow keys will move it in one pixel
increments while you hold down the left mouse button.
Things to remember
z
z

z

z

The pixel coordinate system has its 0,0 at the upper left hand corner and it increases to the right and downwards
The world coordinate system was defined by you but typically starts at the lower left and increases to the right
and up.
3D coordinates were probably defined by your survey instrument and will work fine as long as they are
consistent.
Points not on the rectification plane will give spurious results. When using 3D coordinates these errors should
show up in the Z Deviation column, to the right of the Residuals in the Point List window.

Residuals
The residuals and, if you are using 3D coordinates, the Z deviation values in the point list window are your key to the
reliability of your rectified image. Large values will result in an unreliable rectification.
No residuals can be calculated from a rectification that uses only 4 points (the minimum number) so for confirmation of
your measurements you should have at least 5 points for each image to be rectified, and more is better.
Perfect measurements on a perfect plane with perfect point placement in images of infinite resolution will show zeros
in all columns but in the real world close will have to do.
If your measurements are bad all you can do is eliminate points or remeasure but if your measurements are good, high residual values will
probably be the result of poor point placement in the source image.
In this case select the point with largest residual value, zoom in close
and move that point in the direction opposite the value (for +Y move the
point down, -X move it to the right, etc) then rectify (F5) to see the
changes. Once all the values are about equal the results will be as good
as it is going to get with the points you have.
The residuals are presented in real world units so the maximum error in the rectified image should be the same as the
largest residual.
For a discussion of the Z deviation see the section on 3D coordinates.

Using 3D Coordinates
In order to use 3D coordinates in a 2D application such as ASRix an extra step is required.
A conversion takes place where each 3d point is mapped onto a plane defined by three of the points you are using for
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rectification. These you select in the Point Mapping Window.
In both cases the procedure is the same. To the left of the point numbers you will see three letters indicating the Origin,
Horizontal axis and Vertical axis of the coordinate system you want for the rectified image. By default the first three
points are assigned the O H V (in that order) but you can change this by clicking one of these letters, turning it off, and
then selecting one of the other points by clicking in the space to its left.
If you are doing this in the 3D-2D Mapping Dialogue Box you can select Recalculate to see the effect of your changes
in the deviation column which indicates how close each point is to the selected plane.
On a perfectly flat surface with perfect measurements these deviation values would all be zero but, of course this will
never be the case with real measurements. Still they should be close to zero and any point that has a much larger value
than the others will cause erroneous results and should be examined. The only reasons for a large deviation are
1. a faulty measurement
2. a measurement to a point not on the plane defined by your O H V.
Your only protection from either is redundancy so it is a good idea to have a few more than the minimum 4 points for
each surface or be prepared to return to the site.
If your measurements are perfect and it is a perfect plane you are measuring the deviation column will be all zeros, as is
the case in the 3D cube and bldg samples. It the real world, of course, this will never be the case but it is important that
they be, at least, close.
If one of the points deviates substantially from the plane the point should either be re-measured or deleted but if several
points deviate from the rectification plane the problem is probably with one of the points defining the coordinate
system. The points designated O H V will always show zeros for their Z deviation because it is by these points that the
plane is defined so, if you suspect one of these points try changing them (one at a time) and recalculating the deviation.
When manipulating these points it is important to remember that the definition of the coordinate system is also
responsible for the orientation of the rectified image. The Origin will be near the lower left corner, the Horizontal axis
point will be to the right of that and the Vertical axis will be above the line between the other two. Therefore switching
O and V will give a horizontally mirrored image and image rotation will be affected if your points are not parallel to
something though this can be adjusted through the output parameters dialogue box.
Using the Database Connection
If you have your world coordinates stored in a database this function can be used to automate their entry into the point
mapping dialogue box of ASRix saving a great deal of time and eliminating the possibility of transcription errors.
The file types currently supported include:
z
z
z

dBase III/IV data files
Separated text files
Fixed Field files

To connect a data file you can select the Data icon
from the tool bar, select Database connection from the Tools
menu, select the Change button in the point mapping dialogue box or press F3
You will be presented with the Database Connection dialogue box where you can select the appropriate data file and a
predefined data definition to process it. but of course, the parameters of your data file will have to be defined and
your installation of ASRix configured to search out and correctly parse these files.
How to do this is dealt with in some detail in the section on Data file definitions
Luckily a typical user will have only one type of coordinate data file.
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Alternate Point Files
The
Alternate Points File dialogue box allows the user to define the point mapping in one image and use it in
another. At first glance this might seem a useless exercise but there are a couple of situations where it can be quite
handy.
z

One is the situation where you are forced to add targets to an object in order to have easily identifiable points on
the image but you do not want these targets in your rectified image. In this case you can set your camera on a
tripod and take one photograph with the targets and another without.
You can then rectify the targeted image and save it then open the presentation photograph and rectify it to the
same parameters.
Of course the position and focal length of the camera cannot change between photographs but the ability to
alter the exposure and to add or remove filters greatly increases your ability to ensure that your measured points
are easily identifiable in at least one photo while the features in which you are actually interested are properly
rendered in another.

z

Another situation is when you want to use the points you mapped to a current photograph to another photo of the
same object you found in the archives. (see example 1 below). When you do this the points imported will not be
correct in the second photograph but you can move them into position with the mouse and you won't have to
reenter the coordinates.
If the image in which you mapped the points is larger than the one into which you want use them you may get a
Points out of range warning in which case you may have to zoom out considerably to find these points so you
can move them into position on the image.

Some uses of this feature include:
1. using one set of point coordinates to rectify several images of the same object. For example if you have several
photographs of a surface taken at different times you can measure and rectify one of these images then load a
second one, select the point file of the first and then move the points into the correct positions on the new photo.
2. using points from an adjacent rectification when making a collage
3. using points from a photo containing targets or a grid to rectify a photo with the targets removed of course the
photo must be identical in terms of camera location, direction and focal length
4. you will also use this dialogue box a lot as you work your way through the samples.
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The AutoCAD Interface
The installation of the ASRix menu and utilities for AutoCAD is described in the section on AutoCAD Installation
under Getting Started
z
z
z
z
z
z
z

Introduction
The ASRix menu in AutoCAD
Settings
Working inside AutoCAD
Working Extended Entity Data
Problems
Sample drawings

Introduction to the AutoCAD Interface
ASRix and AutoCAD enjoy a symbiotic relationship wherein AutoCAD provides a 3D geometry and display
environment and ASRix provides rectified images to build 2D and 3D photo mosaics. If an AutoCAD drawing has the
points necessary for rectification those points can be selected and passed to ASRix and, because the rectifier knows
everything about the geometry of the image it can pass that information back to AutoCAD so that the image can be
inserted, scaled and correctly oriented in 3D space.
Exactly how this works and which features are used is configured through the settings utility.
The following brief explanation assumes that, in the settings, everything is turned on.
When you launch ASRix from within AutoCAD you can use a variety of AutoCAD functions to determine the image to
be rectified. The options include:
z

z
z

Extended Entity Data (EED) attached to an AutoCAD entity by the AutoCAD Data Extension (ADE) or your 3rd
party Application
AutoCAD entity characteristics such as text values, layer names and attribute values
or you can simply select a file from a dialog box.

AutoCAD stores the file name for future action then launches ASRix.
You select the image coordinates in ASRix in the usual way though, if your AutoCAD drawing contains entities drawn
with the points you need for rectification you need not enter the real world coordinates (actually should not, as they will
be overwritten anyway). You should also specify the OHV of the coordinate system at this time. When you save the file
you will be returned to AutoCAD, OSNAP (end) will be enabled, as you need the precision and a 3D point cannot be
selected without it. You will then be prompted, one point number at a time, to select the equivalent points in the
drawing. The coordinates extracted from the drawing will be used to update the .PTS file for the image on which you
are working.
Again ASRix will start this time, with the image rectified based on the points you just selected. IF your points are good
you may only have to rearrange the OHVs or fine tune the placement of the image points and re-rectify to obtain
satisfactory results. If there are wrongly placed image points or errors in your field notes (out of sequence point
numbers, illegible notes, etc) there are some trouble shooting options to help you sort things out.
When the rectification is satisfactory and the file is saved you will be returned to AutoCAD for the insertion of the
image.
First you will be asked to select any CAD entities that you want to appear over the image (you won't be able to see
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them afterwards). Typically you choose entities that will help you determine the quality of the rectification and
insertion.
The image will then be inserted into the AutoCAD drawing using the coordinate system defined by your selection of
OVHs and to the scale determined by the rectification.
AutoCAD will then adopt a plan view of the inserted image and prompt you to trim the image by selecting points on it.
Unfortunately this is as far as we've been able to automate this. To see the entities you selected to appear in front of the
image you will have to use AutoCADs REGEN command.
If the points you selected in AutoCAD are consistent with those you chose in ASRix everything is as it should be. If not
there are tools that will detach the image and return you to the rectifier or even to insert the original, un-rectified, image
as a place holder while you return to the field to figure out what is wrong.
As mentioned earlier the settings utility determines which of these options will be invoked and the ASRix menu for
AutoCAD provides commands for these functions as well as a number of utilities to help you find your way around 3D
space, determine point coordinates, trim, annotate and otherwise manipulate the images. There is a detailed description
of each command in the section on the (#)acad-2-menu.txt ASRix AutoCAD menu.

The ASRix Menu in AutoCAD

ASRix The straight rectifier
This command (type ASRix at the command line) simply launches the rectifier in the same way as if you did it from
the file manager or by using a shortcut from your desktop. AutoCAD and ASRix will be unaware of each other.
z

The next group of commands is the easiest way to get started as each command does only one thing. The Settings will
have only a limited effect on these commands, specifically the default image type and whether ASRix will close when
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an image is saved.
ASRr open Rectifier
When you select this item, or type ASRr at the command line, you will be presented with a file selection dialogue box
showing image files of the type specified in the Settings (usually the type you used last time). When you select an
image ASRix will open and allow you to rectify your image in the normal way.
z

ASRp Select Points
When you select this item, or type ASRp at the command line, you will be presented with a list of the PTS files of
rectified images. If there are enough points identified in the file selected you will be prompted to select the
corresponding points in AutoCAD and, when you have selected all the points ASRix will open and attempt to rectify
the image based on the points you have selected.
z

ASRi Insert Rectified Image
This command will insert an already rectified image based on the selected PTS file.
z

SRCi Insert Source Image
Occasionally it is impossible to achieve a satisfactory rectification from the available information. This command will
insert the original source image as a place holder until you can figure out what is wrong with your notes or until you
return to the field to gather the missing measurements. It will be inserted on the plain defined by the OHVs of the PTS
file but must be scaled by the user. It will be on a layer [image]-??? (JPG or BMP) to differentiate it from the [image]ASR layer of the rectified images.
z

The next group of commands is for the experienced user. All the steps required to select points, rectify and insert the
rectified image into the AutoCAD drawing are strung together as specified in the settings.
Settings
Here you specify how you want AutoCAD and ASRix to work together. The {B}ASR command, which launches the
AutoCAD aware rectifier, will behave differently depending on which of these items is selected. If none are selected
ASRix will behave as though you had started it independently of AutoCAD. See the section on settings for more
details.
z

ASR (controlled by settings)
This is the main rectification and insertion command linking AutoCAD and ASRix. It will always start ASRix if it is
given a valid image but how it determines the image name and what it does with it once it is rectified is determined by
the settings. If all settings features are disabled ASRix will behave the same as if it was started outside of AutoCAD if
they are all enabled it will work as outlined earlier.
z

z

Selection Options

z

ASRs Select Image Name
Starts ASRix by asking you to select an image name from a dialogue box after which the settings parameters take
over for the insertion functions.

z

ASRo Get name from Object
Starts ASRix by asking you to select an AutoCAD object then trying to find an image based on AutoCAD entity
data such as text string, attribute value or layer name failing which it will ask you to select an image name from a
dialogue box after which the settings parameters take over for the insertion functions.

z

ASRx Get name from Xdata
Starts ASRix by asking you to select an AutoCAD object then trying to find an image based on AutoCAD
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Extended Entity Data (EED). These values are attached to AutoCAD entities by third party programs such as
AutoCAD Map, CART and other 3rd party add-ons such as surveying packages. If no EEDs are found it will
abort with a message. If an image is found it will be inserted according to the current settings parameters. If you
have a drawing with EEDs but the images are not being located you may have to edit the Xdata routine using the
Edit Xdata command found in the Utilities section of the ASRix menu.
The next group of commands Detach the already inserted images and offer some choices as to what to do with them
after that.
ASRd Detach Image
This will detach an already inserted image whether .ASR or a source (BMP, JPG, etc.). This command (and all the
detach functions) will unlock the image layer if it is locked so be sure you want to do this. Also remember that
detaching an image will remove all instances of that image not just the one you selected.
z

ASRdi Detach and ReInsert
This will detach and reinsert the selected image giving you a chance to select entities to appear on top or to trim it
differently.
z

ASRdr Detatch and ReRectify
This will detach the selected image and give you a chance to change the rectification parameters before reinserting it.
z

The next two groups of commands are intended to facilitate working with the inserted images.
ASRa Annotate an image
This command sets up an environment useful for the annotation of an image. Specifically it:
z

z
z
z

adopts the plan view of the image
adopts the user coordinate system (UCS) of the image
creates a layer [image]-TXT and makes it current

This allows you to make notes or sketches that are on the same plane as the inserted image and on a layer with a related
name.
ASRu Adopt UCS of image
This command simply adopts the UCS of the inserted image selected.
z

ASRv Plan view of image
This command adopts the plan view of the inserted image selected.
z

ASRvu UCS and Plan of image
This command adopts both the plan view and the UCS of the inserted image selected.
z

ASRvp Previous View and UCS
Because there can be several steps involved in the rectification and insertion of an image, a simple AutoCAD View
Previous is not enough to return you to the state before you started the operation. This command performs that
function.
z

I3P Identify 3D Points
This command adds a text string to the drawing with the 3D coordinates of the point selected. Largely left over from
v1.x when AutoCAD did not automatically transfer the 3D coordinates to ASRix, this command was retained mostly
because users found they used it for other things (like labelling elevations in archaeological drawings).
z

z

IC Image Clip
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This will allow you to change the visible area of the image selected by dropping the existing boundaries and using the
AutoCAD command ImageClip using the Polygonal option.
z

Display Order

z

z

M2F - Move to Front
Moves the entities selected to the foreground of the display stack.
i.e. nothing will be displayed on top of it
M2B - Move to Back
Moves the entities selected to the background of the display stack.
i.e. everything will be displayed on top of it

These commands allow you to fine tune the display for presentation purposes. There are several reasons you might
want to do this:
z

z

z

AutoCAD does not consider images when hiding lines so, to get an isometric ** view to look right you will have
to tell AutoCAD which image occludes which.
When preparing a drawing for the internet adjusting the display order can make the layer manipulation through
VoloView or Whip! More intuitive.

Image Frame

Around each image, whether trimmed or not, is a line called the Image Frame. The frames have to be ON to be able to
select the image for any of the previous commands but you will want them OFF for general viewing or to print the
collages.
z

Layer Tools

z

z

z

z

z

OLO Turn One Layer Off
Turns off the layer of the object selected
ASR Image Layers ON / OFF
Manipulate the layers of all the inserted Rectified images (*-ASR)
SRC Image Layers ON / OFF
Manipulate the layers of all UnRrectified images (*-JPG, *-BMP)
TXT Image Layers ON / OFF
Manipulate the layers of all layers created for the ASRa command (*-TXT)
Layer Locking

{

IMGlo ASR generated layers Locked / UnLocked
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Locks or Unlocks all layers generated by ASRix (*-ASR,*-BMP,*-JPG,*-TXT)

z

Utilities

z

Which ASRix?
This command brings up the following information box

which describes where the ASRix software you are currently running is located and where the ASRix.LSP file
that launched it was created.
z

Reload ASRix
Reloads the software supporting the ASRix menu (and the menu itself locating it to the right of most other
menus). The same can be achieved by typing (load "ASRix") at the command line.

z

Reinstall ASRix
This command can only be run from within an ASRix software directory, which means: open the install drawing
from the ASRix menu.
It searches out and deletes all instances of ASRix.LSP from the AutoCAD search path as well as the ASRset.LSP and the compiled ASRix menus. It then gives you the opportunity to select another search path directory
to which to write this file.
This command might be used to test a new release of ASRix without disturbing the old one or to move
ASRix.LSP to a different directory on the AutoCAD search path so that it doesn't disappear during an AutoCAD
upgrade or so that it can be shared by different versions of AutoCAD.
If you Cancel the reinstallation at this point the link between ASRix and AutoCAD will disappear and, if you
want to use these features, you will have to start over at Installation.

z

Xdata Customization

{

GN Get Name
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A troubleshooting command when you are not getting the results you expect from the Xdata setting for the
ASR command. All it does is use the same selection logic to come up with a file name.
{ GEL Get Entity list
Returns the ACAD entity list to help you figure out how the file names are derived.
{ GXL Get Xdata list
Returns the Xdata list to help you figure out how to tweak your Xdata routine to get the results you want
{ Edit Xdata routine
Unload ASR

ASRix Help

AutoCAD Settings

It is here that you specify how you want AutoCAD and ASRix to work together. The ASR command, which launches
the AutoCAD aware rectifier, will behave differently depending on which of these items are selected. If none are
selected ASRix will behave as though you had started it independently of AutoCAD. If all are checked ASRis will
behave as described in the introduction of this section
z

Name extracted from object Xdata
If this is selected you will be prompted to select an AutoCAD entity and ASRix will attempt to locate an image
based on Extended Entity Data (EED) attached to the object selected. By default an entry distinguished by an
ampersand (&) the AutoCAD Data Extension (ADE) code for the primary database for that object. If there is no
ampersand it will use the first EED record it fiinds and if there are no EED values attached it will tell you so
(unless you have the Object Data feature selected as well).

z

Name extracted from CAD Object data
If this is selected you will be prompted to select an AutoCAD entity and ASRix will attempt to locate an image
based on the CAD object. If the object is TEXT it will use the text string. You can type or paste a list of all the
images you want to incorporate into the CAD drawing and then select the items one by one to process and insert
the rectified images. If it is a BLOCK it will look for the first attribute. This is helpful if you use a photo key plan
symbol with an attribute which you set to the image name of that shot. If it is anything else or if there was no
attribute (or EE data if that was selected as well) it will try the layer name and if it still cannot find an image you
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will be given a file selection dialog box so you can browse for the file you want.
z

World coordinate Points selected in AutoCAD
If this is selected you will be expected to supply the world coordinate values by selecting points in AutoCAD.
When you save the file and return to AutoCAD you will be prompted, point by point, to select the point that will
provide the world coordinates for rectification. By default the [end] Object Snap mode is adopted. (no useful
results should be expected without some OSNAP set) When all points have been selected ASRix reopens and
rectifies the image.

z

Close ASRix when image is saved
If this is selected ASRix will close when a file is saved. The only reason you might want to disable this one
would be to have a visual reference of the image points selected while you try to determine their equivalents in
AutoCAD. If this is disabled you need to remember to manually close ASRix when you are done processing an
image or you will end up with a multiplicity of ASRix sessions running simultaneously.

z

Insert image after rectification
If this is selected the image will be inserted into the AutoCAD drawing as soon as you press a key after rectifying
and saving the image. If the rectification was not completed the routine will abort with a message explaining why
it cannot continue.

z

Set Display order before inserting image
If this is selected you will be asked to identify any CAD entities you would like to appear over the image. The
main reason for doing this would be if you have graphic elements in your drawing corresponding to features in
the image. The correlation of the image and the CAD drawing is an indication of the reliability of the
rectification. This option is inserted here because it is much easier to select the CAD entities before the image is
inserted though the display order can be changed at any time.

z

Define View after inserting image
If this is selected AutoCAD will adopt the coordinate system of the image and zoom to a plan view slightly
larger than the image. This view is then saved with the same name as the layer on which the image was inserted
[image-ASR].

z

Trim image after insertion
If this is selected you will be expected to trim the image immediately after the image is inserted. Only the details
on the plane for which you rectified will be to scale and you should trim off anything else. You can pick as many
points as you need to trim the image ending with a return or right click of the mouse.

z

Use Relative path for inserted images
By default AutoCAD will try to use the full path to an inserted image. This makes it difficult to share your
drawings with someone who is not using the same drive designation or directory structure that you do and it even
makes it difficult to move your own work to another drive or directory. If this option is selected ASRix will force
the use of a relative path if your images are in the same directory as the drawing or in a sub-directory under it.

z

Image Directory
This box shows the directory of the last image accessed either relative to your working directory or as an
absolute path depending on the status of the Relative Path check box. This value will be saved with the other
settings and, if you always keep your images in the same directory relative to the working directory, will save
you having to browse for the next image you use.

z

Browse button
This lets you predefine the image directory if you want to save a different directory from the current image
directory with your default settings.

z

Save settings as defaults
Saves the current settings to the file ASR-set.lsp in the ASR software directory.
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Load the default settings
Reads the most recently saved settings from ASR-set.lsp

Using ASRix with AutoCAD
If you've read from here to here, followed the section on the settings and worked through the AutoCAD Samples and
you should have no problems using this tool.
Using ASRix with AutoCAD Extended Entity Data (EED) still needs to be written.

Trouble Shooting in AutoCAD
Once you are satisfied with the look of the rectification and you close ASRix to return to AutoCAD one of two things
will happen:
1. The image will appear on the correct plane with the measured points accurately aligned with their corresponding
AutoCAD entities
2. It won't
In the latter case there are two kinds of errors large and small
Large errors include the image being inserted on the wrong plane
Make sure your coordinate systems match
Small Errors are usually a result of:
z

z

z

The points selected not being on a true plane
Try using different OHVs
Poorly placed points in the image
Detach the image, refine your point placement in ASRix and reinsert
Poorly measured points
Usually its too late to do anything about that

Return to
z
z
z
z
z
z
z

Introduction
The ASRix menu in AutoCAD
Settings
Working inside AutoCAD
Working Extended Entity Data
Problems
Sample drawings

** As of this writing AutoCAD R15 (acad 2002, Map 2004) images are not supported in perspective views.
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The Controls
z

z

z

Input Methods
{ Function Keys
{ Navagation Keys
{ Mouse Functions
The Menus
{ File Menu
{ View Menu
{ Tools Menu
{ Window Menu
{ Help Menu
The Toolbar

Input Methods
z
z
z

Function Keys
Navagation Keys
Mouse Functions

Function Keys
z
z

z
z

z
z

z
z
z
z
z
z

F1 Help
F2 Opens the point mapping dialogue box for the point at the cursor.
Focus must be on the Source Image window.
the Database Connection dialogue box.
F3 Opens
the Output Image Parameters dialogue box
F4 Opens
On closing the image is rectified with the new parameters
F5 Rectifies the image to the current parameters
Arranges the currently open windows for easy viewing.
F6 Tile Group
Focus will be on the Source Image window
F7 Focus changes to the Source Image window
F8 Focus changes to the Points List window
F9 Focus changes to the Rectified Image window
(in current window)
F10 Zoom In
(in current window)
F11 Zoom Out
(in current window)
F12 Zoom Fit

Navigation Keys
z
z
z
z
z
z
z

Insert: undefined
Delete: undefined
Home: undefined
End: undefined
Page Up / Down: If zoomed in scrolls current image in large increments
Arrow Keys If zoomed in scrolls current image in small increments
Arrow Keys + Left Mouse on a point: Moves the point in 1 pixel increments
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Mouse Functions
z

z

z

Left (forefinger) Mouse Button
{ Single click:
On a point: Grabs that point and puts it down when the button is released
Note: while the point is controlled by the mouse the arrow keys will move the point in small increments
for precision placement.
Not on a point: undefined
{ Double click
On a point: brings up edit dialogue box but may also move the point. If the point is already correctly
placed it is better to use F2 to edit it.
Not on a point: adds a new point and brings up edit dialogue
Right (second finger) Mouse Button
{ Single click:
On a point: brings up the Insert-Edit-Zoom dialogue box
Not on a point: brings up the Zoom dialogue box
{ Double click: undefined
Scroll Wheel
{ If your mouse has a Scroll Wheel it will zoom in graphic windows and scroll in the text windows.

The Toolbar

z

File Controls
{ Open
{ Save
{ Print

z

View / Window Controls
{ Source Image (F7)
{ Corrected Image
{ Point List (F8)
{ Rectified Image (F9)
{ Tile Group (F6)

z

Rectification Controls
{ Database Connection (F3)
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Camera Calibration (F2)
Output Image Parameters (F4)
Rectify (F5)

z

Zoom Controls
{ Zoom Reset (F12)
{ Zoom In (F10)
{ Zoom Out (F11)

z

Point Controls
{ Map New Point
{ Delete Point
{ Edit Point

z

Display Properties

z

Alternate Points File

z

Help

The tool bar is activated/deactivated from the View menu.

The Menus
z
z
z
z
z

File Menu
View Menu
Tools Menu
Window Menu
Help Menu

The File Menu
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Completely standard Windows stuff:
Open, Close, Save & Save As
and a list of recently opened images.

The View Menu
allows you to:
z
z

Toggle the Tool and Status bars off and on.
Move the program focus from window to window.
More easily done through the toolbar or with the function keys indicated.

z

Zoom in, out and extents.
Also more easily done through the toolbar or with the function keys.

z

The final item opens the Properties dialogue box wherein you can customize the
colours and precision of the on-screen display.

The Tool Menu
The tools menu provides access to some of the lesser used functions as well as the
main Rectify function. The more commonly used functions are also available using the Function Keys or the Toolbar
icons.
z

brings up the Database Connection dialogue box
Database connection ( F3 )
which allows you to get your world coordinates from a database table or text file
instead of having to enter them manually.

z

opens the Output Image Parameters
Output Image Parameters ( F4 )
dialogue box which provides the tools needed to scale, rotate and mirror the
rectified image. On closing the image will be rectified to the current parameters.
Rectify (F5) performs a rectification of the source image to the current
parameters. These would be either the defaults or the values from the currently
active points and the values set in the Output parameters dialogue boxes.

z

z

Alternate Points File dialogue box which allows you to select an alreadyAlternate PTS file brings up the
saved as a template for your current source image.
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z

Reload PTS File updates the current rectification parameters with the contents of the last saved (or last selected)
points file. This is useful if you want to return to an earlier, stable, situation prior to the last save.

z

Calibrate Camera opens the Camera Calibration dialogue box which provides a tool to reduce the effects of
lens distortion on your rectified image.
Save corrected image After Camera Calibration this option becomes available and will save your calibration
image corrected for lens distortion.

z

z

Install AutoCAD utilities (Not Implemented) This will prompt you to enter a directory on your AutoCAD
search path where it will write a small AutoLisp file ASR.LSP which will install the AutoCAD Menu and
Utilities

The Window Menu
This is pretty much standard Windows fare providing for a variety of ways to tile the windows, none useful, and Tile
As well there is a
Group F7 which is useful but is more easily accessed using the function key or the toolbar icon

list of the open windows which you can use to access the one of your choice.

The Help menu has only 2 options.
z

Help Topics which is what you are reading now in some form or other and which should look something like the
following when you first open it.
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Help About which provides some information about the program which you will need to provide with any bug
reports or queries you might have.
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The Dialogue Boxes
These pages contain detailed descriptions of the dialogue boxes wherein I attempt to explain the function and
possibilities of each box and button.
z
z
z
z
z
z
z

Alternate Point File Dialogue
Camera Calibration Dialogues
Corrected Image Dialogue
Data File Dialogues
Point Mapping Dialogue
Output Parameters Dialogue
Display Properties Dialogue

Point Mapping Dialogue Box
Your main task when using a rectifier is mapping points on your photograph to points in the real world and in ASR you
do this through this dialogue box.

z
z

Number The point number offered can be overwritten by a designation selected by the user
Pixel X & Y These fields show the coordinates of the point on the image. 0,0 is at the upper left corner and
increases to the Right and down.
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Real World Coordinates X, Y & Z (Z is optional but if it is present for one measurement it must be present for
all) These fields must be filled in by the user from measurements taken on site. For a discussion of measurement
techniques see the section: Taking Measurements
Point Status This reference box indicates which function, if any, the point performs in the 3D to 2D
transformation. These values are also used to define the coordinate system for image insertion in AutoCAD.

The Point Mapping dialogue box is accessible in a variety of ways:
z

To establish a new point
{ by double clicking in the source image window
{ from the Edit Mapping New menu item

z

To edit an existing point
{ by pressing F2 while the cursor is at a previously defined point
{ by right clicking on an existing point and selecting Edit
{ by double clicking on a point in the points window
{ by selecting
this icon while a point is highlighted in the points window
{ from the Edit Mapping Edit menu item

For a discussion on accurate point placement see the section on Mapping under Using ASRix.

Output Image Parameters Dialogue Box
This icon, F4 or the Tools->Output Image Parameters menu item will bring up the following dialogue box:

It is divided into 4 sections
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Scaling Factor : which adjusts the size of the rectified image.
Mirroring : which allows the vertical and horizontal mirroring of the rectified image
Rotation : which allows the rotation of of the rectified image
Camera Distortion Parameters : which allows you to select which camera parameters to use for the rectification

Scaling Factor

The first area of this dialogue box deals with the scale of the output image. The first box is read- only and indicates the
natural scale factor which is calculated from the size of the image and the distribution of your measured points. This
value is not significant, we just need a starting point. The scale is in pixels per real world unit.
The "natural" value will be offered as the default when you first rectify an image but the final scale of the rectified
image can (and should) be specified in the second box in this area. Ways to use this feature are as follows:
1. if, at the natural scaling factor, rectification crops part of the image you want to retain decrease this value. Try
rectifying the wall sample at its natural scale factor for an example of this problem.
2. if, at the natural scaling factor, there is a lot of image in which you are not interested you can increase it. The
cube sample at its natural scale factor is an example.
3. if you want a printed image at a particular scale you can use this value to get it. It will take some experimentation
with your printer to get this right but once set up it should work for all images rectified to that scale. A future
release of ASR will try to simplify this procedure but for now, a rectified image that has 30 pixels per inch
printed at 300 DPI should provide some sort of useful result a useful result. *

Mirroring

The second area of this dialogue box has check boxes which will cause the image to be mirrored along either the
horizontal or Vertical axises. The usefulness of this feature is less obvious (we put it in for debugging) but it has it's
applications. For instance a stained glass window that you photographed from inside (because it shows better) but
measured from the exterior (using mullion intersections perhaps ;-) can be integrated into the exterior elevation by
rectifying it to the exterior measurements and mirroring in horizontally.
Note: Do not use this option when rectifying for insertion into AutoCAD.

Rotate Image
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The third section of this dialogue allows for the rotation of the rectified image. This is unlikely to be of much use in the
case of 2D coordinate systems but can be very helpful when working in 3D. In the cube sample try using point #12 for
the Horizontal Axis instead of the default point #1. This will result in a somewhat rotated right face due to the fact that
the O & H points (points # 1 & 12) are not parallel to the base plane.
The rotation tool can be used to overcome a missed measurement at point #2 in a couple of ways:
z

z

Because there are good points along the vertical axis you could define your coordinate system as O=1 H=3 V=4
and then rotate the image 90 degrees clockwise to compensate.
Enter a rotation angle to compensate. In this case a rotation of -6 degrees pretty much straightens things out.

In the latter case this is something you can only decide by trial and error but this is often the best you can do as the real
world is often lacking good points along any of your preferred axes. The wall sample is a real world example of the
same problem except here there are no points on any axis.
Using the default O=1 H=2 V=3 you will have to rectify using:
z horizontal mirroring
z a rotation angle of 273.75 degrees.
Using O=1 H=4 V=2 you can rectify using:
z a rotation angle of 4.75 degrees.
z no mirroring
In both cases you will need a scaling factor of 35 or less to see the peak of the gable
In these cases of inexact rotation angles you can get a pretty good result by selecting a vertical or horizontal line,
zooming in and scrolling your reference line towards an edge to see if they are parallel.
Note: Do not use this option when rectifying for insertion into AutoCAD.

Camera Distortion Parameters

The final section of the Output Parameters dialogue box deals with
the camera distortion parameters you want to use.
If you are revisiting an image you have previously saved the From the PTS file option will be selected and the name of
the camera
is only available if you are revisiting a rectification you have already saved. If there is a camera specified in the PTS
file those parameters will be used for the next rectification unless you change it.

* sorry about the inches. ASR does NOT support any sort of imperialism but especially not measurements it's just that the only printer
information I have on this side of the ocean(s) uses this quaint terminology.

Colour and Display Properties
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At the top is the Colours and Screen display section which allows you to select colours for the display that are easily
visible over the colours of the image with which you are working. To change a colour click the colour patch beside the
element you wish to change and select something appropriate from the pallette offered.
The check boxes to the left of the list of on-screen items control whether that element is displayed at all.
The Precision section allows you to set the number of decimals displayed on screen (to reduce screen clutter) and for
the residual values in the Points List window (in case you need more decimal places to determine rectification
reliability). These settings have nothing to do with the precision with which the transformation is calculated.
The Set as defaults button will store the current settings as the system defaults. These values are computer specific and
are stored in the Windows Registry.
The Restore system defaults button resets the display properties to the system defaults (if you have set them) or the
program defaults if you have not.

Alternate Points File Dialogue Box
This icon or the Alternate Points File item in the Tools menu brings up the Alternate Point File dialogue box. The
upper portion of this box is for reference only and tells you the names of the current files
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(.BMP .PTS .ASR) and the number of points already mapped.
The lower portion allows you to select a point file from the drop-down list and either add the points from that file to
those already mapped or to overwrite the current points with the contents of the chosen file. As you scroll through the
optional point files the upper window will keep you informed as to the number and type of points in each.
Occasionally, when you select a point file you will get a warning that the points are out of the range of the image. The
reason for this is that the current image is smaller, in at least one dimension,
that the image wherein the points were originally mapped. This is not
necessarily an error.
See the section on using alternate point files for the possible uses of this
feature.
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Once configured all you need to do to attach a data file is click the File Open
button and browse for the data file
containing the coordinates for the current image Once you have selected a data file the values in these fields, for the
point number being identified, will be offered as the default for the World Coordinate Points for each point selected.
First select a Database point file. You will be presented with a dialogue box displaying data files of the type you used
last time. To change the file type drop down the list Files of Type
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The extensions listed will be those for which you have prepared Data Definitions

Trouble Shooting
Occasionally it happens that your field notes become out of sync with your recording. The Adjust database points
field addresses this possibility by allowing you to adjust all point numbers up or down a few to see if this is the case
when you get severely distorted results.
The other cause of really bad results is being connected to the wrong database.
The Update from Database button refreshes the world coordinates for all points.

Data Definitions
DATAFILE.DBF
Eventually there will be a tool that will allow you to parse your own data files but for the time being you can do one of
the following:
1. Name your files for the definitions we have already prepared
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We have included definitions for every file type sent to us by users which are described below
2. Try editing the ASRix.INI file to build your own data definition
Take a look at the sample ASRix.INI and the descriptions below before you decide to do this and be sure to keep
a copy of the original.
3. Send us a sample of your data file format and we'll send you a revised ASRix.INI
Send your sample file to: steve@icomos.org

Data File Definitions
z

DBF Files
For DBF files you will have to add a piece to ASRix.INI. Look for the DBF:CART entry and add a section
describing your DBF file similar to, or replacing it:
[DBF:CART]
description=CART DBF file
point=P_NO
X=PT_X
Y=PT_Y
Z=PT_Z

where:
{ [DBF:XXX] the DBF is the file extension and the XXX being a short key for your definition which must
be unique.
{ description= a short text description
{ point= the name of the field where the point number is to be found
{ X= the name of the field where the X coordinate is to be found
{ Y= the name of the field where the Y coordinate is to be found
{ Z= the name of the field where the Z coordinate is to be found
z

Seperated Files
Most of the files you might get containing coordinate data will be of this type, usually comma, tab and space
separated files exported from the common spread sheet and database management programs. Even when these
programs export a text file there is a delimiter somewhere that will allow these files to be parsed.
Most common would be the CDF or CSV file
This example is from data\CART.CDF (exported from dBase III)
1.0,0.0000,5.0000,1.5000,"FRONT"
2.0,8.7420,0.1440,1.5000,"FRONT"
3.0,8.7420,0.1440,4.5000,"FRONT"
4.0,0.0000,5.0000,4.5000,"FRONT"

The ASRix.INI entry for this file looks like this:
[CDF:CART]
description=CDF export from dBaseIII fields 1234
separators=","
firstline=1
point=field1
X=field2
Y=field3
Z=field4

The seperator is a comma
firstline=1 means to start at the top of the file (i.e. there is no header)
The first field is the point number, followed by coordinates X, Y & Z
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This one is from data\CART.CSV (exported from Excel or Access)
P_NO,PT_X,PT_Y,PT_Z,P_ID
1.0,0.0000,5.0000,1.5000,FRONT
2.0,8.7420,0.1440,1.5000,FRONT
3.0,8.7420,0.1440,4.5000,FRONT
4.0,0.0000,5.0000,4.5000,FRONT

The definition for this file is identical to the one above, only the extension is different
[CSV:1234]
description=CSV from Excel fields 1234
separators=","
firstline=1
point=field1
X=field2
Y=field3
Z=field4

Fixed length file (also exported from Excel)
1.00
2.00
3.00
4.00

0.00
8.74
8.74
0.00

5.00
0.14
0.14
5.00

1.50
1.50
4.50
4.50

FRO
FRO
FRO
FRO

This works as a separated file because any leading or trailing blanks or zeros are removed during parsing so
making the separator a space " " is all that is required.
[FIX:1234]
description=TXT from Excel fields 1234
separators=" "
firstline=0
point=field1
X=field2
Y=field3
Z=field4

The same definition would work for a proper Space Separated file such as that below:
1.00
2.00
3.00
4.00

0.00
8.74
8.74
0.00

5.00
0.14
0.14
5.00

1.50
1.50
4.50
4.50

"FRONT"
"FRONT"
"FRONT"
"FRONT"

Text File
data\CART.TXT (exported from Excel)
----------------------------------------------------------------------------------------------------------|
P_NO
|
PT_X
|
PT_Y
|
PT_Z
|
P_ID
|
----------------------------------------------------------------------------------------------------------|
1 |
0 |
5 |
1.5 | FRONT
|
----------------------------------------------------------------------------------------------------------|
2 |
8.742 |
0.144 |
1.5 | FRONT
|
----------------------------------------------------------------------------------------------------------|
3 |
8.742 |
0.144 |
4.5 | FRONT
|
----------------------------------------------------------------------------------------------------------|
4 |
0 |
5 |
4.5 | FRONT
|
-----------------------------------------------------------------------------------------------------------

This format is slightly more complicated as you have to skip every second line
[TXT:Excel]
description=Excel file
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separators="| "
firstline=3
filter1=(0,NE,"--")
point=field1
X=field2
Y=field3
Z=field4

Here the separator is the pipe "|"
You need a filter to skip the lines (--------) filter1=(0,NE,"--")
The first line could be either 3 or 4
Tab Delimited File
data\CART.TAB (exported from Excel)
1.00
2.00
3.00
4.00

0.00
8.74
8.74
0.00

5.00
0.14
0.14
5.00

1.50
1.50
4.50
4.50

"FRONT"
"FRONT"
"FRONT"
"FRONT"

Make sure it really is a tab and not several spaces
[PKT:Antonio]
description=Antonio's PKT file
separators="\t"
firstline=0
point=field1
X=field2
Y=field3
Z=field4

/t is the code for TAB
Fixed Field Data Files
Here it gets really ugly but you might get something like this from your survey equipment.
10NMVAR.TAIPALE
13CPKorj.merenp.: E
13CPK ja R korjaus: E
13CPS korjaus: E
06NM1.00000000
13OOT m n ytt",HAV
13TS03-Jun-03 12:40
13JS10000
08KI33756911144.173547575.7683.9700000KP
08KI31086911194.863547610.9083.9700000KP
01NM:
106486
00000031
13PCPrismavakio mm Sovellettu: 0.000
02TP33756911144.173547575.7683.97000001.52000000KP
13TLPystyk.Tol.virhe: Pno: 3108 0.0194
07TP3375310838.5877736383.330000
03NM1.44500000
09F13375310861.6800000100.058000383.330000KP
08TP10006911194.863547610.9083.9888057KP
09F13375100061.6800000100.058000383.330000KP
13TS03-Jun-03 12:50
08TP10016911155.853547557.6683.9786836KP
09F13375100121.5400000100.196000281.222000KP
08TP10026911180.833547541.0484.9349828KP
09F13375100250.500000098.8780000296.472000KP
13TS03-Jun-03 14:26
02TP10016911155.853547557.6683.97868361.51500000KP
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13TLEtmTol.virhe: Pno: 1002 0.019
13TLPystyk.Tol.virhe: Pno: 1002 0.0361
07TP10011002362.62585095.2600000
09F11001100230.000000098.084000095.2600000KP
08TP10036911144.163547575.7883.9924655KP
09F11001100321.5600000100.166000269.130000KP

This file came from Sokkia equipment and you need to know quite a lor about it before you can make it work.
The definition in ASRix.INI looks like this:
[SDR:Karim]
description=Sokkia 7.2 digits
point=(4,4,N)
X=(8,10,F)
Y=(18,10,F)
Z=(28,5,F)
filter1=(0,EQ,"08TP")

z

The key is knowing that the lines with coordinates start with 08TP hence the filter filter1=(0,EQ,"08TP")
Once we have a useful line we get the point number by starting at the 4th character and using the next 4 point=
(4,4,N) (the N indicates that it is a whole Number (no decimals)
Then for the X coordinate we start at the 8th and use the next 10 X=(8,10,F) it is 7 digits a decimal and 2 decimal
places so it is followed by an F (for Float)
By now Y=(18,10,F) and Z=(28,5,F) should be self explanatory.
Database File: dia-data9b
1.00
2.00
3.00
4.00
5.00
6.00
7.00
8.00
9.00
10.00
11.00
12.00
13.00
14.00
15.00
16.00
17.00
18.00
19.00
20.00
21.00
22.00
23.00
24.00
25.00
26.00
27.00
28.00
29.00
30.00
31.00
32.00
33.00
34.00

0.00
8.74
8.74
0.00
3.88
0.00
0.00
1.94
3.88
0.00
8.74
10.68
1.94
4.37
9.71
6.31
0.97
12.82
3.88
12.62
3.88
8.74
12.82
8.74
10.68
12.62
12.62
3.88
10.68
1.94
1.65
1.65
2.23
2.23

5.00
0.14
0.14
5.00
11.99
5.00
5.00
8.49
11.99
5.00
0.14
3.64
8.49
2.57
1.89
6.06
6.74
7.13
11.99
7.13
11.99
0.14
7.13
0.14
3.64
7.13
7.13
11.99
3.64
8.49
7.98
7.97
9.02
9.01
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1.50
1.50
4.50
4.50
1.50
1.50
4.50
7.85
4.50
4.50
4.50
7.85
7.85
4.50
6.17
7.85
6.17
1.50
1.50
4.50
4.50
1.50
1.50
4.50
7.85
4.50
4.50
4.50
7.85
7.85
2.27
4.48
2.25
4.44

FRO
FRO
FRO
FRO
LEF
LEF
LEF
LEF
LEF
ROO
ROO
ROO
ROO
ROO
ROO
ROO
ROO
BAC
BAC
BAC
BAC
RIG
RIG
RIG
RIG
RIG
ROO
ROO
ROO
ROO
WIN
WIN
WIN
WIN
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1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
200
201
202
203
204
205
206
207
208
209
210

0.0000
8.7420
8.7420
0.0000
3.8850
0.0000
0.0000
1.9430
3.8850
0.0000
8.7420
10.6840
1.9430
4.3710
9.7130
6.3130
0.9710
12.8270
3.8850
12.6270
3.8850
8.7420
12.8270
8.7420
10.6840
12.6270
12.6270
3.8850
10.6840
1.9430
1.6570
1.6510
2.2360
2.2300
100.061
106.106
112.134
118.248
102.070
118.025
107.323
110.839
107.646
110.532
108.192
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5.0000
0.1440
0.1440
5.0000
11.9930
5.0000
5.0000
8.4970
11.9930
5.0000
0.1440
3.6400
8.4970
2.5720
1.8920
6.0680
6.7480
7.1370
11.9930
7.1370
11.9930
0.1440
7.1370
0.1440
3.6400
7.1370
7.1370
11.9930
3.6400
8.4970
7.9820
7.9710
9.0240
9.0140
100.089
100.124
100.139
100.157
100.026
99.865
105.097
105.100
105.104
105.129
84.644

1.5000
1.5000
4.5000
4.5000
1.5000
1.5000
4.5000
7.8560
4.5000
4.5000
4.5000
7.8560
7.8560
4.5000
6.1780
7.8560
6.1780
1.5000
1.5000
4.5000
4.5000
1.5000
1.5000
4.5000
7.8560
4.5000
4.5000
4.5000
7.8560
7.8560
2.2790
4.4820
2.2510
4.4480
114.418
114.388
114.438
114.450
101.886
101.001
106.470
106.469
101.133
101.053
101.684

1,682088.602,563583.756,11.816,
5,682084.872,563542.996,12.396,
1313,682097.636,563528.453,17.836,
,0.000,0.000,0.000,
353,682087.852,563576.741,11.687,202
354,682088.846,563583.240,11.778,202
,0.000,0.000,0.000,
001.000000.000,000005.000,1.500,123
002,000008.742,000000.144,1.500,123
003,000008.742,000000.144,4.500,123
004,000000.000,000005.000,4.500,123
005,000003.885,000011.993,1.500,123
006,000000.000,000005.000,1.500,123
007,000000.000,000005.000,4.500,123
008,000001.943,000008.497,7.856,123
009,000003.885,000011.993,4.500,123
010,000000.000,000005.000,4.500,123
011,000008.742,000000.144,4.500,123
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012,000010.684,000003.640,7.856,123
013,000001.943,000008.497,7.856,123
014,000004.371,000002.572,4.500,123
015,000009.713,000001.892,6.178,123
016,000006.313,000006.068,7.856,123
017,000000.971,000006.748,6.178,123
018,000012.827,000007.137,1.500,123
019,000003.885,000011.993,1.500,123
020,000012.627,000007.137,4.500,123
021,000003.885,000011.993,4.500,123
022,000008.742,000000.144,1.500,123
023,000012.827,000007.137,1.500,123
024,000008.742,000000.144,4.500,123
025,000010.684,000003.640,7.856,123
026,000012.627,000007.137,4.500,123
027,000012.627,000007.137,4.500,123
028,000003.885,000011.993,4.500,123
029,000010.684,000003.640,7.856,123
030,000001.943,000008.497,7.856,123
031,000001.657,000007.982,2.279,123
032,000001.651,000007.971,4.482,123
033,000002.236,000009.024,2.251,123
034,000002.230,000009.014,4.448,123
400,682092.883,563483.047,17.352,214
401,682091.141,563481.712,17.141,214
402,682089.875,563479.633,17.328,214
403,682091.207,563478.013,17.853,214
404,682093.090,563476.568,18.452,214
405,682095.405,563478.339,18.473,214
406,682097.430,563481.119,18.378,214
407,682096.067,563482.749,17.901,214
408,682093.537,563482.442,17.213,214
409,682091.643,563480.366,17.126,214
410,682093.327,563479.397,17.490,214
411,682095.027,563480.352,17.617,214
412,682095.156,563481.979,17.550,214
413,682074.114,563530.688,11.096,581
414,682066.946,563525.772,9.655,115
415,682066.263,563526.232,9.495,521
416,682082.983,563469.389,18.468,804
417,682060.679,563456.057,16.900,804
50,682082.070,563512.952,20.649,
51,682086.561,563538.620,19.077,
1313,57.054,479.015,15.657,
,0.000,0.000,0.000,
1,2.970,493.503,9.508,
5,38.629,473.584,10.067,
1313,682097.323,563528.406,17.975,
,0.000,0.000,0.000,
416,682083.059,563469.356,18.472,804
417,682060.686,563456.058,16.895,804
51,682093.097,563543.300,19.109,
50,682076.356,563523.336,20.686,
1313,682061.597,563471.497,15.761,
,0.000,0.000,0.000,
418,682064.904,563468.833,14.594,519
419,682064.361,563465.103,15.465,519
420,682063.891,563462.146,15.884,519
421,682064.409,563458.599,16.642,519
422,682066.069,563455.914,17.817,519
423,682069.514,563455.778,18.430,519
424,682073.321,563457.452,18.642,519
425,682077.002,563459.647,18.939,519
426,682079.479,563463.158,18.834,519
427,682081.368,563466.264,18.793,519
428,682080.119,563469.214,17.714,519
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429,682078.428,563471.376,16.875,519
430,682075.278,563472.419,16.144,519
431,682070.640,563472.551,15.644,519
432,682067.642,563471.930,14.683,519
433,682066.697,563466.089,14.292,519
434,682065.583,563464.274,14.387,519
435,682065.949,563462.725,14.462,519
436,682066.062,563459.931,14.866,519
437,682067.267,563459.189,14.815,519
438,682069.866,563460.605,14.979,519
439,682072.699,563463.020,14.940,519
440,682074.106,563464.708,14.712,519
441,682076.179,563465.814,15.022,519
442,682077.168,563469.157,15.017,519
443,682075.685,563470.810,15.172,519
444,682072.041,563469.455,14.465,519
445,682068.580,563470.970,14.578,519
1,682046.572,563417.465,9.657,
5,682067.637,563452.453,10.214,
1313,682098.608,563528.529,17.931,
,0.000,0.000,0.000,
446,682069.014,563524.360,9.993,115
447,682074.600,563530.884,11.126,531

10NMVAR.TAIPALE
13CPKorj.merenp.: E
13CPK ja R korjaus: E
13CPS„„korjaus: E
06NM1.00000000
13OOT„m„ n„ytt”,HAV
13TS03-Jun-03 12:40
13JS10000
08KI33756911144.173547575.7683.9700000KP
08KI31086911194.863547610.9083.9700000KP
01NM:
106486
00000031
13PCPrismavakio mm Sovellettu: 0.000
02TP33756911144.173547575.7683.97000001.52000000KP
13TLPystyk.Tol.virhe: Pno: 3108 0.0194
07TP3375310838.5877736383.330000
03NM1.44500000
09F13375310861.6800000100.058000383.330000KP
CART data
09F0000
08TP00010000000.0000000005.000 1.5000000XX
09F0000
08TP00020000008.7420000000.144 1.5000000XX
09F0000
08TP00030000008.7420000000.144 4.5000000XX
09F0000
08TP00040000000.0000000005.0004.5000000XX
09F0000
08TP00050000003.8850000011.9931.5000000XX
09F0000
08TP00060000000.0000000005.0001.5000000XX
09F0000
08TP00070000000.0000000005.0004.5000000XX
09F0000
08TP00080000001.9430000008.4977.8560000XX
09F0000
08TP00090000003.8850000011.9934.5000000XX
09F0000
08TP00100000000.0000000005.0004.5000000XX
09F000
08TP00110000008.7420000000.1444.5000000XX
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09F000
08TP00120000010.6840000003.6407.8560000XX
09F000
08TP00130000001.9430000008.4977.8560000XX
09F000
08TP00140000004.3710000002.5724.5000000XX
09F000
08TP00150000009.7130000001.8926.1780000XX
09F000
08TP00160000006.3130000006.0687.8560000XX
09F000
08TP00170000000.9710000006.7486.1780000XX
09F000
08TP00180000012.8270000007.1371.5000000XX
09F000
08TP00190000003.8850000011.9931.5000000XX
09F000
08TP00200000012.6270000007.1374.5000000XX
09F000
08TP00210000003.8850000011.9934.5000000XX
09F000
08TP00220000008.7420000000.1441.5000000XX
09F000
08TP00230000012.8270000007.1371.5000000XX
09F000
08TP00240000008.7420000000.1444.5000000XX
09F000
08TP00250000010.6840000003.6407.8560000XX
09F000
08TP00260000012.6270000007.1374.5000000XX
09F000
08TP00270000012.6270000007.1374.5000000XX
09F000
08TP00280000003.8850000011.9934.5000000XX
09F000
08TP00290000010.6840000003.6407.8560000XX
09F000
08TP00300000001.9430000008.4977.8560000XX
09F000
08TP00310000001.6570000007.9822.2790000XX
09F000
08TP00320000001.6510000007.9714.4820000XX
09F000
08TP00330000002.2360000009.0242.2510000XX
09F000
08TP00340000002.2300000009.0144.4480000XX
Sokkia data
08TP10006911194.863547610.9083.9888057KP
09F13375100061.6800000100.058000383.330000KP
13TS03-Jun-03 12:50
08TP10016911155.853547557.6683.9786836KP
09F13375100121.5400000100.196000281.222000KP
08TP10026911180.833547541.0484.9349828KP
09F13375100250.500000098.8780000296.472000KP
13TS03-Jun-03 14:26
02TP10016911155.853547557.6683.97868361.51500000KP
13TLEtmTol.virhe: Pno: 1002 0.019
13TLPystyk.Tol.virhe: Pno: 1002 0.0361
07TP10011002362.62585095.2600000
09F11001100230.000000098.084000095.2600000KP
08TP10036911144.163547575.7883.9924655KP
09F11001100321.5600000100.166000269.130000KP
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1.00 0.00 5.00 1.50 "FRONT"
2.00 8.74 0.14 1.50 "FRONT"
3.00 8.74 0.14 4.50 "FRONT"
4.00 0.00 5.00 4.50 "FRONT"
5.00 3.88 11.99 1.50 "LEFT"
6.00 0.00 5.00 1.50 "LEFT"
7.00 0.00 5.00 4.50 "LEFT"
8.00 1.94 8.49 7.85 "LEFT"
9.00 3.88 11.99 4.50 "LEFT"
10.00 0.00 5.00 4.50 "ROOF"
11.00 8.74 0.14 4.50 "ROOF"
12.00 10.68 3.64 7.85 "ROOF"
13.00 1.94 8.49 7.85 "ROOF"
14.00 4.37 2.57 4.50 "ROOF"
15.00 9.71 1.89 6.17 "ROOF"
16.00 6.31 6.06 7.85 "ROOF"
17.00 0.97 6.74 6.17 "ROOF"
18.00 12.82 7.13 1.50 "BACK"
19.00 3.88 11.99 1.50 "BACK"
20.00 12.62 7.13 4.50 "BACK"
21.00 3.88 11.99 4.50 "BACK"
22.00 8.74 0.14 1.50 "RIGHT"
23.00 12.82 7.13 1.50 "RIGHT"
24.00 8.74 0.14 4.50 "RIGHT"
25.00 10.68 3.64 7.85 "RIGHT"
26.00 12.62 7.13 4.50 "RIGHT"
27.00 12.62 7.13 4.50 "ROOF2"
28.00 3.88 11.99 4.50 "ROOF2"
29.00 10.68 3.64 7.85 "ROOF2"
30.00 1.94 8.49 7.85 "ROOF2"
31.00 1.65 7.98 2.27 "WINDOW"
32.00 1.65 7.97 4.48 "WINDOW"
33.00 2.23 9.02 2.25 "WINDOW"
34.00 2.23 9.01 4.44 "WINDOW"

Only lines starting with "CART" will be considered
X & Y values are 7.3 digits Z values are 4.3 digits
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART12341234567.1231234567.1231234.123XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00010000000.0000000005.0000001.500XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00020000008.7420000000.1440001.500XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00030000008.7420000000.1440004.500XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00040000000.0000000005.0000004.500XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00050000003.8850000011.9930001.500XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00060000000.0000000005.0000001.500XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00070000000.0000000005.0000004.500XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00080000001.9430000008.4970007.856XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00090000003.8850000011.9930004.500XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00100000000.0000000005.0000004.500XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00110000008.7420000000.1440004.500XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00120000010.6840000003.6400007.856XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
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CART00130000001.9430000008.4970007.856XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00140000004.3710000002.5720004.500XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00150000009.7130000001.8920006.178XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00160000006.3130000006.0680007.856XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00170000000.9710000006.7480006.178XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00180000012.8270000007.1370001.500XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00190000003.8850000011.9930001.500XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00200000012.6270000007.1370004.500XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00210000003.8850000011.9930004.500XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00220000008.7420000000.1440001.500XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00230000012.8270000007.1370001.500XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00240000008.742000000.14400004.500XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00250000010.6840000003.6400007.856XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00260000012.6270000007.1370004.500XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00270000012.6270000007.1370004.500XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00280000003.8850000011.9930004.500XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00290000010.6840000003.6400007.856XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00300000001.9430000008.4970007.856XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00310000001.6570000007.9820002.279XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00320000001.6510000007.9710004.482XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00330000002.2360000009.0240002.251XX
TESTnnnnXXXXXXX.xxxYYYYYYY.yyyZZZZ.zzz??
CART00340000002.2300000009.0140004.448XX

1.00
2.00
3.00
4.00
5.00
6.00
7.00
8.00
9.00
10.00
11.00
12.00
13.00
14.00
15.00
16.00
17.00
18.00
19.00
20.00

0.00
8.74
8.74
0.00
3.88
0.00
0.00
1.94
3.88
0.00
8.74
10.68
1.94
4.37
9.71
6.31
0.97
12.82
3.88
12.62

5.00
0.14
0.14
5.00
11.99
5.00
5.00
8.49
11.99
5.00
0.14
3.64
8.49
2.57
1.89
6.06
6.74
7.13
11.99
7.13

1.50
1.50
4.50
4.50
1.50
1.50
4.50
7.85
4.50
4.50
4.50
7.85
7.85
4.50
6.17
7.85
6.17
1.50
1.50
4.50

"FRONT"
"FRONT"
"FRONT"
"FRONT"
"LEFT"
"LEFT"
"LEFT"
"LEFT"
"LEFT"
"ROOF"
"ROOF"
"ROOF"
"ROOF"
"ROOF"
"ROOF"
"ROOF"
"ROOF"
"BACK"
"BACK"
"BACK"
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21.00
22.00
23.00
24.00
25.00
26.00
27.00
28.00
29.00
30.00
31.00
32.00
33.00
34.00

3.88
8.74
12.82
8.74
10.68
12.62
12.62
3.88
10.68
1.94
1.65
1.65
2.23
2.23

11.99
0.14
7.13
0.14
3.64
7.13
7.13
11.99
3.64
8.49
7.98
7.97
9.02
9.01
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4.50
1.50
1.50
4.50
7.85
4.50
4.50
4.50
7.85
7.85
2.27
4.48
2.25
4.44

"BACK"
"RIGHT"
"RIGHT"
"RIGHT"
"RIGHT"
"RIGHT"
"ROOF2"
"ROOF2"
"ROOF2"
"ROOF2"
"WINDOW"
"WINDOW"
"WINDOW"
"WINDOW"

----------------------------------------------------------------------------------------------------------- | P_NO | PT_X | PT_Y |
PT_Z | P_ID | ----------------------------------------------------------------------------------------------------------- | 1 | 0 | 5 |
1.5 | FRONT | ----------------------------------------------------------------------------------------------------------- | 2 |
8.742 | 0.144 | 1.5 | FRONT | ---------------------------------------------------------------------------------------------------------- | 3 | 8.742 | 0.144 | 4.5 | FRONT | ---------------------------------------------------------------------------------------------------------- | 4 | 0 | 5 | 4.5 | FRONT | ---------------------------------------------------------------------------------------------------------- | 5 | 3.885 | 11.993 | 1.5 | LEFT | ---------------------------------------------------------------------------------------------------------- | 6 | 0 | 5 | 1.5 | LEFT | ---------------------------------------------------------------------------------------------------------- | 7 | 0 | 5 | 4.5 | LEFT | ---------------------------------------------------------------------------------------------------------- | 8 | 1.943 | 8.497 | 7.856 | LEFT | ---------------------------------------------------------------------------------------------------------- | 9 | 3.885 | 11.993 | 4.5 | LEFT | ---------------------------------------------------------------------------------------------------------- | 10 | 0 | 5 | 4.5 | ROOF | ---------------------------------------------------------------------------------------------------------- | 11 | 8.742 | 0.144 | 4.5 | ROOF | ---------------------------------------------------------------------------------------------------------- | 12 | 10.684 | 3.64 | 7.856 | ROOF | ---------------------------------------------------------------------------------------------------------- | 13 | 1.943 | 8.497 | 7.856 | ROOF | ---------------------------------------------------------------------------------------------------------- | 14 | 4.371 | 2.572 | 4.5 | ROOF |
----------------------------------------------------------------------------------------------------------- | 15 | 9.713 | 1.892 |
6.178 | ROOF | ----------------------------------------------------------------------------------------------------------- | 16 |
6.313 | 6.068 | 7.856 | ROOF | ---------------------------------------------------------------------------------------------------------- | 17 | 0.971 | 6.748 | 6.178 | ROOF | ---------------------------------------------------------------------------------------------------------- | 18 | 12.827 | 7.137 | 1.5 | BACK | ---------------------------------------------------------------------------------------------------------- | 19 | 3.885 | 11.993 | 1.5 | BACK | ---------------------------------------------------------------------------------------------------------- | 20 | 12.627 | 7.137 | 4.5 | BACK | ---------------------------------------------------------------------------------------------------------- | 21 | 3.885 | 11.993 | 4.5 | BACK | ---------------------------------------------------------------------------------------------------------- | 22 | 8.742 | 0.144 | 1.5 | RIGHT | ---------------------------------------------------------------------------------------------------------- | 23 | 12.827 | 7.137 | 1.5 | RIGHT | ---------------------------------------------------------------------------------------------------------- | 24 | 8.742 | 0.144 | 4.5 |
RIGHT | ----------------------------------------------------------------------------------------------------------- | 25 | 10.684 |
3.64 | 7.856 | RIGHT | ----------------------------------------------------------------------------------------------------------- |
26 | 12.627 | 7.137 | 4.5 | RIGHT | ---------------------------------------------------------------------------------------------------------- | 27 | 12.627 | 7.137 | 4.5 | ROOF2 | ---------------------------------------------------------------------------------------------------------- | 28 | 3.885 | 11.993 | 4.5 | ROOF2 | ---------------------------------------------------------------------------------------------------------- | 29 | 10.684 | 3.64 | 7.856 | ROOF2 | ---------------------------------------------------------------------------------------------------------- | 30 | 1.943 | 8.497 | 7.856 | ROOF2 | ---------------------------------------------------------------------------------------------------------- | 31 | 1.657 | 7.982 | 2.279 | WINDOW | ---------------------------------------------------------------------------------------------------------- | 32 | 1.651 | 7.971 | 4.482 |
WINDOW | ----------------------------------------------------------------------------------------------------------- | 33 | 2.236
| 9.024 | 2.251 | WINDOW | ---------------------------------------------------------------------------------------------------------- | 34 | 2.23 | 9.014 | 4.448 | WINDOW | ----------------------------------------------------------------------------------------------------------
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In the Camera Calibration dialog box allows you to select a camera definition as the default or "None" if you are
using scans of film images (or if you have not yet calibrated your digital camera )
The Delete button will remove the highlighted camera definition from the ASRix.INI file and Done will close the
Camera Calibration utility and return you to your project.
The Add or Edit buttons will bring up the Calibration Parameters dialog box:

To calculate your camera's distortion parameters based on the current image and PTS file select the Calibrate
button. The A1 and A2 fields will change to show distortion parameters calculated from the George Karras
algorithms.
If you know the other parameters, in the Karras format, from a complete camera calibration you can enter them
manually or you can select the Import button which will bring up the Import Camera Parameters dialogue
box which will allow you to enter parameters obtained from other sources.
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Import Camera Parameters
(not yet implemented)
The Import Camera Parameters dialogue box allows you to use camera calibration parameters obtained from
other sources including:
{ A .PTS file from another installation of ASRix
{ Parameters from the George Karras algorithms
{ Parameters in the format used by the ADAM Stereo Plotter
{ Parameters in the ISPRS format
{ Parameters provided by ORIENT
{ Manual Entry
The X0 and Y0 are optional but will be used for image correction if they are available. You would only get this
information from a total camera calibration and the improvement in the precision of the correction will be only
marginal. Still if you have this information you might as well use it.
Read the calibration parameters from an existing .PTS file by selecting the Import button.
Calibration parameter formats currently supported are:
z

The Karras format is the native format of ASRix
It uses only K1 and K2, setting A0 to 0
A0 = 0
A1 = K1
A2 = K2
If you have calibration parameters in this format you can enter them directly in the first Calibration Parameters
dialogue box without going into the Import option.

z

ADAM stereoplotter format

which uses A0, A1 and A2
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DR(R) = A0 * R + A1 * R ^ 3 + A2 * R ^ 5
In this formulae the value of r0 is included in the computation of A0, A1 and A2
z

ISPRS format

which uses r0, A1 and A2
A0 = (-A1 * r0 ^ 2 - A2 * r0 ^ 4)
A1 = A1
A2 = A2
z

ORIENT format

which uses r0, ap3 and ap4
A0 = (-A1 * r0 ^ 2 - A2 * r0 ^ 4)
A1 = ap3 / r0 ^ 3
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A2 = ap4 / r0 ^ 5

The View Corrected Image dialogue box is really just the bottom section of the Output Parameters dialogue
box. It allows you to select camera distortion parameters from either the PTS file (if it exists) or from the camera
definitions you have prepared using the Camera Calibration feature of ASRix.
Selecting the PTS file radio button, if it's available, will select the camera parameters stored in the current PTS
file while selecting the Camera Description radio button will allow you to choose any camera for which you
have entered calibration data.
The View button will open a window displaying the source image corrected for lense distortion but not rectified.
The Save .COR. button will allow you to save the corrected image. By default it will go to the same directory as
the source image with a .COR. inserted between the file name and the extension.
The Done button will save the current values in the dialogue box so that they will be used for the next
rectification or as the starting point the next time the Output Parameters dialogue box is opened for this project.
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The Windows

z

Source Image Window ( F7 )
image.

Clicking on this icon will pass focus to the window containing the source

z

Point List Window ( F9 )

Clicking on this icon will pass focus to the window containing the point list.

z

Corrected Image Window
for lense distortion.

Clicking on this icon will open the window containing the source image corrected

z

Rectified Image Window ( F8 )
image.

z

The Status Bar

z

Tile Group ( F6 )
Clicking on this icon will arrange the open windows with the Point List Window as a band
across the bottom of whatever other windows are currently open.

Clicking on this icon will pass focus to the window containing the rectified

Source Image Window
This window contains the source image.

z

When the cursor is in this window the coordinates in the status bar display pixel coordinates coordinates

z

Double clicking in this window will bring up the point mapping dialogue box, allowing the input of the world
coordinates for the point selected.

z

Right clicking in this window will bring up the following menu:
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The "Select Print Area" option allows you to select a rectangle in the image to send to a printer.

Point List Window
This window contains the point list.
Each line represents one of your mapped points

These columns show:
1. The numbers of each point (Number)
2. The pixel coordinates (Pixel-X, Y) indicating the location of the point
on the source image.
3. The world coordinates (World-X, Y, Z) entered for each point
4. The residuals of each point (X, Y-residual)
5. The amount each point deviates from the rectification plane (Z-deviation)
z

Double clicking in this window will bring up the point mapping dialogue box, allowing the input of the world
coordinates for the point selected.

z

Right clicking on a point line in this window will bring up the point menu:

{

{
{
{

z

Wherein:
New will bring up the point mapping dialogue box with a pixel mapping of 0,0 (upper left corner) which
can then be moved into position with the mouse.
Delete will delete the currently selected point
Edit will bring up the point mapping dialogue box with the mapping of the currently selected point.
Enabled allows you to temporarily disable a point when trouble shooting. Disabled points will be deleted
when the rectification is saved.

If you are using 3D coordinates there will also be, to the left of the point numbers, three letters indicating the
Origin,
Horizontal axis and
Vertical direction of the coordinate system for the rectified image. You can change these assignments by clicking
one of these letters, turning it off, and then selecting one of the other points by clicking in the space to its left.

Corrected Image Window
This window contains the source image corrected for camera distortion but before rectification. It is provided
primarily for a quick check as to whether you are using the correct camera calibration parameters.
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This window will not be accessible if you are not using camera calibration so, if lines you know to be straight appear to
be curved in this window you should revisit the camera calibration and select a different camera definition or recalibrate this camera/lens combination
z

Right clicking in this window will bring up the following menu:
The "Select Print Area" option allows you to select a rectangle in the image to send to a printer.

Rectified Image Window
This window, if it is available, contains the rectified image.
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z

When the cursor is in this window the coordinates in the status bar display real world coordinates though there
are some problems with this feature.

z

Neither clicking or double clicking in this window has any effect.

z

Right clicking in this window will bring up the following menu:
Select Print Area allows you to select a rectangle in the image to send to a printer.
Select Base Line allows you to draw a line which will become horizontal on the rectified
image.

The Status Bar
On opening the status bar, along the bottom of the ASR window, will look something like the one below
though if there is no image open the window with the 50%, indicating the zoom factor of the current window would be
blank. The other windows in this example (CAP, NUM, SCRL) indicate the status of your keyboard. As well, the left
hand corner will display some brief explanations for the control currently under the pointer.

Please Note: With the change to 3D coordinates the coordinate displays described below have become unreliable.
We're working in this :(
When the focus is on the Source Image window the co-ordinate display becomes active showing the pixel co-ordinates
of the current pointer position.
When the focus is on the Rectified Image window the co-ordinate display becomes active showing the world coordinates of the current pointer position.

The status bar is activated / deactivated from the View menu.
(which are currently open) so that the source
( F7 ) will assemble all of the windows for the current project
image is on the left, the rectified image is on the right and the point file is displayed, (full width) across the bottom as
seen below.
z
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(which are currently open) so that the source
( F7 ) will assemble all of the windows for the current project
image is on the left, the rectified image is on the right and the point file is displayed, (full width) across the bottom as
seen below.
z
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Source Image Window
This window contains the source image.
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z

When the cursor is in this window the coordinates in the status bar display pixel coordinates coordinates

z

Double clicking in this window will bring up the point mapping dialogue box, allowing the input of the world
coordinates for the point selected.

z

Right clicking in this window will bring up the zoom menu.

Corrected Image Window

This window contains the source image corrected for camera distortion but before rectification it is provided
primarily for a quick check as to whether you are using the correct camera calibration parameters.
This window will not be accessible if you are not using camera calibration so, if lines you know to be straight appear to
be curved in this window you should revisit the camera calibration and select a different camera definition or recalibrate this camera/lens combination
z

Right clicking on a point line in this window will bring up the point menu,

Rectified Image Window
This window, if it is available, contains the rectified image.
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z

When the cursor is in this window the coordinates in the status bar display real world coordinates though there
are some problems with this feature.

z

Neither clicking or double clicking in this window has any effect.

z

Right clicking in this window will bring up the zoom menu.

Point List Window
This window contains the point list.

Each line represents one of your mapped points

These columns show:
1. The numbers of each point (Number)
2. The pixel coordinates (Pixel-X, Y) indicating the location of the point
on the source image.
3. The world coordinates (World-X, Y, Z) entered for each point
4. The residuals of each point (X, Y-residual)
5. The amount each point deviates from the rectification plane (Z-deviation)
z

Double clicking in this window will bring up the point mapping dialogue box, allowing the input of the world
coordinates for the point selected.
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Right clicking on a point line in this window will bring up the point menu,
Wherein:
{ New will bring up the point mapping dialogue box with a pixel mapping of 0,0
(upper left corner) which can then be moved into position with the mouse.
{ Delete will delete the currently selected point
{ Edit will bring up the point mapping dialogue box with the mapping of the
currently selected point.
z If you are using 3D coordinates there will also be, to the left of the point numbers,
three letters indicating the
Origin,
Horizontal axis and
Vertical direction of the coordinate system for the rectified image. You can change these assignments by clicking
one of these letters, turning it off, and then selecting one of the other points by clicking in the space to its left.

The Status Bar
On opening the status bar, along the bottom of the ASR window, will look
something like the one above though if there is
no image open the window with the 50%, indicating the zoom factor of the current window would be blank. The other
windows in this example (CAP, NUM, SCRL) indicate the status of your keyboard. As well, the left hand corner will
display some brief explanations for the control currently under the pointer.
When
the focus is on the
Source Image window the coordinate display becomes active showing the pixel co-ordinates of the current pointer position.
When the focus is on the
Rectified Image
window the co-ordinate display becomes active showing the world co-ordinates of the current pointer position.
The status bar is activated / deactivated from the View menu.
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Trouble Shooting
z
z
z
z
z
z

Butterflies
Image Orientation
All Black Images
Cropped Images
Help Doesn't Display
Bug Reports

Butterflies

Butterflies like this are generally the result of having some of your points transposed (mapped to the wrong point on the
image.
Another possibility is a point with 0.0 values (ie. one where you forgot to enter the world coordinates)
Checking the residuals and / or the Z deviation will help you find the problem.

Incorrect Orientation of output image
Incorrect orientation of rectified images may occur when using 3D coordinates and is a result the

O H of your O H Vs not being parallel to the objects base line.
This can be corrected by using the rotation options in the Output Parameters dialogue box or by changing the base
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points through either the Point List window or the 3D to 2D Mapping facility.

Black Images
On some older laptops some images will appear as all

black. The solution to this is to convert the source image to 24 bit colour using an image processor.

Cropped Images
Occasionally when you rectify an image parts of it will be missing like the top of the

wall sample rectified at the natural scale factor.
This problem can be resolved by lowering scale factor in the Output Parameters dialogue box.

Help doesn't display
Either the file ASRix.CHM is unavailable or Internet Explorer 3.0 or later has not been installed.

Please send your bug reports to steve@icomos.org
Please include the relevant .BMP and .PTS files of the image causing the problem as well as the version and build
numbers of the ASR version you were using. (available from the Help->About information box)

The .PTS file
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This file contains the configuration and mapping parameters for the image of the same name. It should never be edited
manually but it is kept in ASCII format so that the rectification could be reconstructed if someone without ASR
software wanted to assess its accuracy and the reliability of the measurements obtainable from the rectified image.
z

The first line contains the version and build information needed for bug reports
#ASRix v.1.0(100) Build No 199

Which is followed by the point count and the mapping of each point
5
(01)
(02)
(03)
(04)
(05)
{
{

{

z

505.6
768
520
848
681.5

945.6
644
433.6
215.2
570.5

0
9
0
10
5

0
0
0
0
0

0
1
10
10
5

The value in the ()s is the point number
The next two values are the pixel co-ordinates (0,0 is the upper left corner of the image, X increments to
the right and Y increments downward)
The last three values are the World co-ordinates

The Common data section stores your window sizes and locations, your choices for colours, coordinate system
axises (for 3D), precision (set in the Display Properties dialogue box) and some rectification parameters.
[Common data]
0x17
0x808000 0xffff 0 0xff 0xffff00 0x800080
0 2
2 1
SRCWND(0,0,380,364)
RCTWND(381,0,761,364)
PTSWND(0,365,761,537)
BASEPTS(0,2,1)
RECTPARMS(-21.1803,18.3076,0.0240442,-0.0240442)

z

The Rectification Data section stores the scale, rotation and mirroring values followed by the residuals (X Y) for
each point
[Rectification Data]
50 90 0 0
0.0148371 -0.00692122 0
0.0239059 0.0281454 0
0.0191248 0.0225163 0
0.0148371 -0.00692122 0
-0.0727049 -0.0368193 0

The .PTS files for the sample images are shown below.
z

The tape example

1,682088.602,563583.756,11.816,
5,682084.872,563542.996,12.396,
1313,682097.636,563528.453,17.836,
,0.000,0.000,0.000,
353,682087.852,563576.741,11.687,202
354,682088.846,563583.240,11.778,202
,0.000,0.000,0.000,
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001.000000.000,000005.000,1.500,123
002,000008.742,000000.144,1.500,123
003,000008.742,000000.144,4.500,123
004,000000.000,000005.000,4.500,123
005,000003.885,000011.993,1.500,123
006,000000.000,000005.000,1.500,123
007,000000.000,000005.000,4.500,123
008,000001.943,000008.497,7.856,123
009,000003.885,000011.993,4.500,123
010,000000.000,000005.000,4.500,123
011,000008.742,000000.144,4.500,123
012,000010.684,000003.640,7.856,123
013,000001.943,000008.497,7.856,123
014,000004.371,000002.572,4.500,123
015,000009.713,000001.892,6.178,123
016,000006.313,000006.068,7.856,123
017,000000.971,000006.748,6.178,123
018,000012.827,000007.137,1.500,123
019,000003.885,000011.993,1.500,123
020,000012.627,000007.137,4.500,123
021,000003.885,000011.993,4.500,123
022,000008.742,000000.144,1.500,123
023,000012.827,000007.137,1.500,123
024,000008.742,000000.144,4.500,123
025,000010.684,000003.640,7.856,123
026,000012.627,000007.137,4.500,123
027,000012.627,000007.137,4.500,123
028,000003.885,000011.993,4.500,123
029,000010.684,000003.640,7.856,123
030,000001.943,000008.497,7.856,123
031,000001.657,000007.982,2.279,123
032,000001.651,000007.971,4.482,123
033,000002.236,000009.024,2.251,123
034,000002.230,000009.014,4.448,123
400,682092.883,563483.047,17.352,214
401,682091.141,563481.712,17.141,214
402,682089.875,563479.633,17.328,214
403,682091.207,563478.013,17.853,214
404,682093.090,563476.568,18.452,214
405,682095.405,563478.339,18.473,214
406,682097.430,563481.119,18.378,214
407,682096.067,563482.749,17.901,214
408,682093.537,563482.442,17.213,214
409,682091.643,563480.366,17.126,214
410,682093.327,563479.397,17.490,214
411,682095.027,563480.352,17.617,214
412,682095.156,563481.979,17.550,214
413,682074.114,563530.688,11.096,581
414,682066.946,563525.772,9.655,115
415,682066.263,563526.232,9.495,521
416,682082.983,563469.389,18.468,804
417,682060.679,563456.057,16.900,804
50,682082.070,563512.952,20.649,
51,682086.561,563538.620,19.077,
1313,57.054,479.015,15.657,
,0.000,0.000,0.000,
1,2.970,493.503,9.508,
5,38.629,473.584,10.067,
1313,682097.323,563528.406,17.975,
,0.000,0.000,0.000,
416,682083.059,563469.356,18.472,804
417,682060.686,563456.058,16.895,804
51,682093.097,563543.300,19.109,
50,682076.356,563523.336,20.686,
1313,682061.597,563471.497,15.761,
,0.000,0.000,0.000,
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418,682064.904,563468.833,14.594,519
419,682064.361,563465.103,15.465,519
420,682063.891,563462.146,15.884,519
421,682064.409,563458.599,16.642,519
422,682066.069,563455.914,17.817,519
423,682069.514,563455.778,18.430,519
424,682073.321,563457.452,18.642,519
425,682077.002,563459.647,18.939,519
426,682079.479,563463.158,18.834,519
427,682081.368,563466.264,18.793,519
428,682080.119,563469.214,17.714,519
429,682078.428,563471.376,16.875,519
430,682075.278,563472.419,16.144,519
431,682070.640,563472.551,15.644,519
432,682067.642,563471.930,14.683,519
433,682066.697,563466.089,14.292,519
434,682065.583,563464.274,14.387,519
435,682065.949,563462.725,14.462,519
436,682066.062,563459.931,14.866,519
437,682067.267,563459.189,14.815,519
438,682069.866,563460.605,14.979,519
439,682072.699,563463.020,14.940,519
440,682074.106,563464.708,14.712,519
441,682076.179,563465.814,15.022,519
442,682077.168,563469.157,15.017,519
443,682075.685,563470.810,15.172,519
444,682072.041,563469.455,14.465,519
445,682068.580,563470.970,14.578,519
1,682046.572,563417.465,9.657,
5,682067.637,563452.453,10.214,
1313,682098.608,563528.529,17.931,
,0.000,0.000,0.000,
446,682069.014,563524.360,9.993,115
447,682074.600,563530.884,11.126,531

#ASRix v.2.0(100) Build No 435 Licensed to
#C:\Program Files\CART\ASRix\Samples\TAPE-3t.jpg
6
(0000000001)
782
391
0
(0000000002)
762
865
0
(0000000003)
739
1542
0
(0000000004)
2050
334
2035
(0000000005)
2103
814
2035
(0000000006)
2175
1493
2035
[Common data]
0x13
0x808000 0xffff 0 0xff 0xff0080 0x800080
0 2
2 2
SRCWND(0,0,399,356)
RCTWND(400,0,798,356)
PTSWND(0,357,799,535)
BASEPTS(-1,-1,-1)
RECTPARMS(-1156.99,289.318,1.51515,-1.51515)
CAMERAPARMS(None,0,0)
[Rectification Data]
0.66 0 0 0
-0.938325 1.68652 0
2.47402 -2.93195 0
-1.5357 1.24543 0
0.365776 -0.35005 0
-1.44344 0.526299 0
1.07766 -0.17625 0
[ASR Image Data]

-235
-1035
-2035
-200
-1000
-2000
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(0000000001)
(0000000002)
(0000000003)
(0000000004)
(0000000005)
(0000000006)

[
[
[
[
[
[

]
]
]
]
]
]

763.617
763.617
763.617
2106.72
2106.72
2106.72
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346.05
874.05
1534.05
322.95
850.95
1510.95

The .INI file
[General info]
Dbtypes=dbf,cdf,csv,pkt,pts,pkt,txt,sdr,fix,spa,tab,str
Default database type=DBF:CART
Default camera=None
[Camera Calibration Data]
Nickerson=-1.522669e-007, -2.199604e-013
Kodak=6.122527e-008, -5.796604e-014
Nikon=9.248774e-008, -8.409139e-014
Nikon-1=9.248774e-008, -8.409139e-014
[SDR]
type=fixed
description=string with leading 08TP
[SDR:Karim]
description=Sokkia 7.2 digits
point=(4,4,N)
X=(8,10,F)
Y=(18,10,F)
Z=(28,5,F)
filter1=(0,EQ,"08TP")
[STR]
type=fixed
description=string with leading CART
[STR:CART]
description=text string 7.3:7.3:4.3 digits
point=(4,4,N)
X=(8,11,F)
Y=(19,11,F)
Z=(30,8,F)
filter1=(0,EQ,"CART")
[DBF]
type=dbf
description=DBF file
[DBF:CART]
description=CART DBF file
point=P_NO
X=PT_X
Y=PT_Y
Z=PT_Z
[DBF:Parks]
description=Parks Canada
point=NO
X=X
Y=Y
Z=Z
[CDF]
type=separated
description=CSV comma seperated
[CDF:CART]
description=CART separated file
separators=","
firstline=0
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point=field1
X=field2
y=field3
Z=field4
filter1=(field4,NE,"0.")
[CSV]
type=separated
description=CSV comma seperated
[CSV:1234]
description=CSV from Excel fields 1234
separators=","
firstline=1
point=field1
X=field2
Y=field3
Z=field4
[FIX]
type=separated
description=Fixed length text file
[FIX:1234]
description=TXT from Excel fields 1234
separators=" "
firstline=0
point=field1
X=field2
Y=field3
Z=field4
[PKT]
type=separated
description=PKT separated file
separators="\t"
[PKT:Antonio]
description=Antnio's PKT file
firstline=0
point=field1
X=field2
Y=field3
Z=field4
[PTS]
type=separated
description=PTS separated file
[PTS:Karim]
separators=","
firstline=0
point=field1
X=field2
Y=field3
Z=field4
filter1=(field1,NE," ")
[SPA]
type=separated
description=Fixed length text file
[SPA:1234]
description=Space delimited from Excel fields 1234
separators=" "
firstline=0
point=field1
X=field2
Y=field3
Z=field4
[TAB]
type=separated
description=TAB separated file
separators="\t "
[TAB:Excel]
description=TAB delimited from Excel
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firstline=0
point=field1
X=field2
Y=field3
Z=field4
[TXT]
type=separated
description=Simple Text file
[TXT:Excel]
description=Excel file
separators="| "
firstline=3
filter1=(0,NE,"--")
point=field1
X=field2
Y=field3
Z=field4

Some Known Bugs and Workarounds
z
z
z

Display Problems on Laptops
Incorrect World Co-ordinates
Bug Reports

Display Problems on Laptops
On some older laptops some images will appear as all black. The solution to this is to convert the source image to 24
bit colour using an image processor.

Incorrect World Co-ordinates
The World Coordinates box in the status bar are often incorrect. This seems to depend on the number of points used for
the rectification
z
z

4 and 7 points give pretty good results
anything else is unreliable (to varying degrees)

The rectified image in these cases is still reliable. Only the on-screen display of the World co- ordinates is incorrect.
This is a problem that will require some fixing. :(

Bug Reports
Please send your bug reports to asr@nickerson.icomos.org
Please include the relevant .BMP and .PTS files of the image causing the problem as well as the version and build
numbers of the ASR version you were using. (available from the Help->About information box)
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The Samples
z

Rectification Sample Files
{ CUBE a 3D grid to help you get your bearings.
{ BUILDING an oblique photograph of a simple building wherein you can rectify both the front and the
roof and, to some extent, one end.
{ WALL a real-world example with points in both 2D and 3D
{ WINDOW A real photo with imaginary coordiantes
{ TAPES Demonstrating a method for gathering measurements from a vertical surface

z

AutoCAD Sample drawings
{ CUBE.DWG A simple 3 dimensional cube onto the surfaces of which you can paste an image of the same
cube. The idea is to put the image where you intended to and to make it fit perfectly
{ BUILDING.DWG Slightly closer to the real world this drawing gives you a 3D representation of a
building and invites you to clad it with rectified images.
{ WALL.DWG A real-world example of an architectural surface where the world coordinates can be
obtained either from survey information in a database or points plotted in the drawing
{ ARCHAEOL.DWG An archaeological example wherein you build a photo collage in AutoCAD

z

Data Files
{ In the sub-directory Samples/data there are a number of data files of different formats to help you get
started with the Data Connection feature of ASRix.

z

PTS Files
{ In the sub-directory Samples/images/pts point files similar to those you would get by doing the ASRix
and AutoCAD sample exercises.

Sample Files
{
{

{
{
{

CUBE a 3D grid to help you get your bearings.
BUILDING an oblique photograph of a simple building wherein you can rectify both the front and the roof
and, to some extent, one end.
WALL a real-world example with points in both 2D and 3D
WINDOW A real photo with imaginary coordinates
TAPES Demonstrating a method for gathering measurements from a vertical surface

cube.bmp is a CAD generated image of a 10x10x10 cube that is helpful for visualizing how the rectifier works
with both 2D and 3D objects. When you first open this file there will be no points associated with it (though this
will change if you save it after performing the experiments outlined below).
As a first test establish a point at each corner of the right hand surface as shown below:
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Rectifying it should give you a result such as follows:

Then try swapping two of the corners diagonally opposite:

Then two of the corners from one edge:
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There are also a few pre-defined points files for this cube which you can load using the Alternate Points File
feature. They are:
{ cube-left.pts which has four points defined for the left hand plane.
{ cube-right.pts which has seven points defined for the right hand plane (none at the corners)
{ cube-top.pts which has five points defined for the top.

building.jpg
Imagine that you found a foundation (6 metres long) and a door (2 metres high) and this old photograph.
Assuming these dimensions you could rectify the image and get at least an idea of it's front elevation. As we
know nothing about the camera make sure the Camera distortion parameters are set to none in the Output
Parameters dialogue box.

This would give you a result something like this:
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From the same image you could even learn something about the roof by simply moving the points and assuming
a value for the roof slope. I used 2.5 metres based on the approximate proportion of the height of the corner and
the length of the roof slope.

It seems to show more roof sag than you would guess looking at the original image.
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If you have AutoCAD you can play with this image some more in conjunction with the drawing wall.dwg
wall.JPG is a real world example. There should be no default point file (unless it has already been rectified and
saved)

The alternate point file wall-2D.PTS is a 2D example which where the points were established by survey then
projected onto a 2D plane using AutoCAD.
wall-3D.PTS uses the original 3D points from the survey.

file://C:\Documents and Settings\Steve\Local Settings\Temp\~hh2484.htm

21/01/2005

Samples-ASRix Help

Page 6 of 27

These are good samples to explore how moving a point changes things and what the residuals are trying to tell
you.
If you have AutoCAD you can play with this image some more in conjunction with the drawing wall.dwg
window.jpg is a photograph of a window where you can use arbitrary 2D coordinates to get a variety of results.
Try making it square but shown as though it was being viewed from the inside.
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TAPES
The main difficulty with using rectified photography is the problem of getting good world coordinates. It's easy if
you always have a surveyor handy but it is also possible for a single photographer to get some pretty good
measurements with the addition of a few simple tools.
This example uses two modified tape measures, one normal tape measure, a tripod and some sort of level (only
necessary if there are no horizontal lines on the surface being photographed).
The modified tape measures can even be of the evil variety common in North America where both imperial and
metric scales are present. Get a good, black, felt pen and darken half the tape every second 10 centimetres.

These divisions are visible from quite a distance in an image with reasonable resolution and you can count them
to get a dimension. Hang these tapes on the surface to be rectified, preferably from a horizontal feature then
measure the distance between them with the third tape. As long as they are hanging freely you can assume them
to be vertical (and parallel) due to gravity.
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If there are no suitable horizontal features, as in the example below, hang them from whatever you can find and
determine the vertical relationship between the two either by noting the measurement to a horizontal feature
lower down (a foundation for instance) or use a level to figure this out. In this case we used a laser pointer with a
bubble level on the camera tripod.
Once you have noted the relationship between the tapes (distance apart and the difference vertically) put the
camera on the tripod and take a picture of the surface and the dangling tapes. Then remove the tapes and take a
second picture.

The rectified image above was created from the image below:
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with points transferred from the next image using the alternate point file feature of ASRix.
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The tapes were 2035 mm apart and the one on the left was 235 mm lower than the one on the right. They were
assumed to be parallel because of gravity.

There are 4 AutoCAD drawings included as samples
The ASRix menu and utilities must be installed and you should have thoroughly explored the section on the
AutoCAD Interface before you tackle these examples.
The examples won't work as described unless you start your AutoCAD session by selecting one of the sample
drawings from the ASRix menu under Start->Programs->ASRix->Samples->Drawings
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cube.dwg A simple 3 dimensional cube onto the surfaces of which you can paste an image of the same
cube. The idea is to put the image where you intended to and to make it fit perfectly
building.dwg Slightly closer to the real world this drawing gives you a 3D representation of a building and
invites you to clad it with rectified images.
wall.dwg A real-world example of an architectural surface where the world coordinates can be obtained
either from survey information in a database or points plotted in the drawing
archaeol.dwg An archaeological example wherein you build a photo collage in AutoCAD

cube.dwg
z

Start with the sample CUBE.DWG The image below shows both the axonometric drawing and the perspective
view that was used to create the images used in this exercise.

z

Before you start you should check your Settings where everything should be checked except "World Coordinate
points selected in AutoCAD"
What we're going to try to do is cover this cube with rectified images using 3D coordinates for rectification. You
should be in Model Space looking at an isometric view of the box above and the various coloured text needs to
be visible.

z

First we will rectify GREY.BMP and put it on the bottom of the 3D grid in the CAD drawing. Start by selecting
ASR from the menu or by typing it at the command line. You will get a pickbox and the prompt to Select entity:
You should select the grey text at which time one of two things will happen.
1. ASRix will start with the image GREY.BMP
2. You will be presented with some variation of the following dialogue box
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where you may have to change the file type in the file dialogue box to BMP and you may have to browse to find
the image (it should be in the Images subdirectory under Samples) Once you have located and opened
GREY.BMP you shouldn't see this dialogue box again during the exercise as ASRix assumes that you will be
using the same image type and image location until told otherwise.
Once you have GREY.BMP open in ASRix locate points as shown below using the following world coordinates:
#
1
2
3
4
5

X
0
10
0
10
5

Y
0
0
10
10
5

Z
0
0
0
0
0

For point #1 you will get the unlikely point data message, which is normal when world coordinates are 0,0,0, as
this usually means you forgot to enter the values or connect a database.
Once GREY.BMP is rectified to your satisfaction (be sure your camera is set to None) save it and you will be
returned to AutoCAD which has been waiting with the prompt: Select any CAD entities you want to appear
over this image:
In this case select everything and press Enter.
A bunch of stuff will happen quite quickly after which you should be presented with a view something like the
following, and a prompt: Press any key to trim image (ESC to quit):
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To do a neat job of trimming the image you might want to turn on AutoCADs Object Snap ENDpoint by
pressing F3 and checking the appropriate box. You will need to do this each time as ASRix turns it off as it is
generally a bother when working with real images where you seldom have points on the exact corners of
anything and lots of other points to confuse things.
Once the image is trimmed to your satisfaction the command ASRVP will restore the starting view and you
should be left with a drawing that looks something like the following:

If you got here the first time you tried to follow these instructions you are doing better than most. It is kind of a
flaky interface until you get used to it because of the need to get AutoCAD to wait while you do the rectification
so one keystroke out of place can crash the routine. The good news is that, as long as you saved the rectification,
it's easy to go back.
{ If the image didn't get inserted try ASRI (insert) or just start over
{ If it was inserted wrong or the rectification turns out to have been incorrect try ASRDR (detach reinsert)
{ If the trimming didn't go well use IC (image clip)
After a successful insertion try using UNDO to go backwards through the steps (it takes 18 UNDOs to
completely return to the beginning). This will give you a better idea what is going on and an idea of what might
go wrong.
Next use BLUE.BMP and put the left face of the image on the left face of the drawing using the following world
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coordinates.
#
1
2
3
4
5

X
0
10
0
10
5

Y
0
0
0
0
0

Z
0
0
10
10
5

Next try moving BLUE.BMP to the back surface of the cube in the drawing by changing the world coordinates in
ASRix. To do this use the command ASRDR (Detach and Rectify)
BLUE.BMP will reopen and rectify then, in the Points List Window double click on each point and change the Y
value of the world coordinates to 10 so that they look like this:
#

X

Y

Z
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0
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10
10
10
10
10

0
0
10
10
5

and paste the left face of RED.BMP on the other back surface of the cube using these coordinates
#
1
2
3
4
5

X
10
10
10
10
10

Y
10
0
10
0
5

Z
0
0
0
10
5

The result should look like this:

#
1
2
3
4
5

X
0
10
0
10
5

Y
0
0
0
0
o

Z
0
0
10
10
5
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building.dwg
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Start with the sample BUILDING.DWG

What we're going to try to do is cover this simple shape with rectified images. Unlike the cube the world coordinates
are not immediately obvious so there are two possibilities:
1. Get them from a data file
2. Select them in the AutoCAD drawing
We'll do the front and left side using the database values
z

In Settings everything should be checked except World Coordinate points selected in AutoCAD

z

Start by selecting ASR (controlled by settings) from the menu or by typing ASR at the command prompt.
You will get a Select entity: prompt, and you can select anything in the drawing that is magenta to start a search
for the image FRONT.JPG The front wall works because it is on layer FRONT, the camera symbol works
because it has an attribute value FRONT and the text works for reasons you can probably deduce. The image
should be in the IMAGES subdirectory under SAMPLES though, to find it, you may have to change the file type
in the file selection dialogue box to JPG.

z

In ASRix select the bottom left corner of the building and when you get the Point Mapping dialogue box, select
the Change button for the Database point file and select building.dbf in the Samples directory.

z

If there is a choice, select CART dbf file in the Select predefined part box.

z

select the other three corners, travelling in a counter clockwise direction to match the order of the point numbers
as shown in the drawing. As you select each point the point number will increment and the world coordinates
will be supplied by the database.

z

Rectify and Save. ASRix will close and you will be returned to AutoCAD with the prompt:
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wall.dwg
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Alternate points 3D

Alternate points 2D
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Settings: points in AutoCAD

points 6 & 7 reversed
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archaeol.dwg
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Help!
I hope the help system for ASR is pretty much self explanatory, please let me know where you find problems. Send
such comments and inquires to: steve@icomos.org
There are five main areas in the help file:
1. Getting Started Primarily for those who don't / won't use Help.
2. Using ASR contains discussions on why to use the various features with some comments on how to implement
these in the field.
3. The Controls explains the icons, menus and input options.
4. Dialogue Boxes contains explanations on how to use the different dialogue boxes.
5. Windows contains explanations on the uses of the different windows.
these are followed by a few other items of general interest.
It should be noted that the folders, as well as the pages, are linked to documents containing the overviews of the
different areas and should be considered before going on to the sub-topics. In general look in the Getting Started and
using sections for the why and everything else for the how.
Either the icon or the help menu item Help > Topics should launch the Html Help file ASRix.CHM or, if you prefer
(for reasons of resolution, font size, etc.) there is also a local HTML version available.
For the latest updates check the on-line ASR Help

The help menu item
Help About displays
some information about the program that we will probably need for trouble shooting. With the demo version it will
display build information and days to expiry in the title bar The licenced version displays the licencee in the title bar
with the build information in the body. Please include this licencee name and build number in all correspondence.

ASRix Help has been created using CARTHTML and then processed using Microsoft's Html Help Workshop into
ASRix.CHM which is distributed with the rectifier.
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Future Developments
ASR is undergoing rapid development with the following ideas scheduled for future releases. Please let us know what
you would like to see added to this list and we'll see what we can do.
z

Printing the rectified images with scaling information so the scale of the print can be known (if you know the
DPI of the printer)

z

Save/Save As will be able to specify which files are to be saved with check boxes for .PTS .ASR .BMP instead
of saving everything as is the case at present.

z

Merge multiple images using common real-world points

z

Specify a baseline on screen for 3D image orientation.
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Ordering Instructions
Please check the current pricing then send your request along with a cheque or money order to:
Steve Nickerson
501-99 Holland Ave.
Ottawa, Ontario
Canada - K1Y 0Y1
Please include:
1. Full name and mailing co-ordinates
2. The name to which the program should be registered.
3. A contact email address
In special circumstances other means of payment may be considered.
You can contact us in the following ways:
z

Email: steve@icomos.org

z

Voice: +1 613 798-7717
Fax: +1 613 725-2312

z

z

or write to:
Steve Nickerson
501-99 Holland Ave.
Ottawa, Ontario
Canada - K1Y 0Y1
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